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Get started with CheckBook Pro
Introduction
It’s tempting to say that CheckBook Pro is the best personal nance manager you’ll ever buy. Well,
it is a simply powerful tool - but the truth is it’s nothing special without you, the user. Take a few
minutes to learn some basics and we promise you’ll get a lot more out of the app. We’ll show you
how to create an Accounts document, set up your rst Account, and begin creating Entries. When
we’re done you’ll be ready to take control of your nances.
Thanks for choosing CheckBook Pro. We’re happy to have your support!
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Create your Accounts document
The rst time you open CheckBook Pro you’ll see the Launch window. It looks like this:

CheckBook Pro’s Launch window

Click the Create a New Accounts Document button and CheckBook Pro will present a window
asking where you want to save your Accounts document. Type a name in the Save As eld at the
top of the window, choose a folder where you’d like to save your Accounts document (we
recommend the Documents folder in your Home folder) and click the Create button at the
bottom right of the window. CheckBook Pro will open your new Accounts document and show
you the Account options sheet.

Create your Accounts document
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Name your rst Account
Name your new Account so it’s easy to remember what it’s meant to do. Will you record
transactions from your current account? If so, name it "Current". Will you have several Accounts
but this one will represent an Account at Second National Bank? Name the Account "Second
National".
When you know what you’d like to name your Account, type the name into the Account Name
eld at the top of the Account options sheet.

Account options: Account Name
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Name your rst Account
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Your Starting Balance
When you start using CheckBook Pro you may choose to enter your previous nancial history by
hand, back to a speci c date. Enter your “Real World” balance just before that date in the Starting
Balance eld.

Account options: Starting Balance
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Your Starting Balance
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Currency
For each of your Accounts, CheckBook Pro displays amounts with a currency symbol and
appropriate formatting. CheckBook Pro groups these settings into a Currency. As you set up your
Account you’ll get to choose from a default set of Currencies. If the Currency for your locale isn’t
in the list you can use one of the defaults for now and set up your own Currency later.

Account options: Currency
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Currency
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We're not done yet!
You've set up the Account Name and Starting Balance, so you could start using CheckBook Pro
right now. But there are still three more sections in the Account options sheet to explore, so let's
keep moving!
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AutoCompletion
Let's talk about AutoCompletion - one of the ways CheckBook Pro saves you time that you'll
appreciate as you create and edit your Account's Entries.
CheckBook Pro tracks some of the Entry details you've used before, then compares those details
with what you're typing in the current Entry. When it sees you're typing "Groceries" in the current
Entry it looks around to see if you’ve ever entered something that starts with “Groceries” before.
If it nds a match, like “Groceries at the corner store”, it’ll ll in the rest automatically so you don't
have to.
What if you've typed "Groceries at the corner store" before, but you've also typed in "Groceries at
Wally World"? As you type the word "Groceries", CheckBook Pro will match that with the last
item that started with “Groceries” - so if you entered "Groceries at the corner store" more
recently than “Groceries at Wally World” it’ll automatically ll in “Groceries at the corner store”. If
you keep typing "Groceries at Wally World", though, the instant you press the rst "W" CheckBook
Pro will automatically type the rest of “Groceries at Wally World” for you. In general, keep typing
and CheckBook Pro will try to nd the best match. And, when you type in something completely
new, CheckBook Pro remembers that for next time.
AutoCompletion works when you're typing in an Entry's To/From, Category and Description elds,
and you get a say in how some of it works. Click the Descriptions button at the top of the
Account options sheet and let's continue.

Account options: Click the Descriptions button.
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Descriptions
Here’s where you set up AutoCompletion for the Description eld in each Entry.
First, choose how CheckBook Pro comes up with matches for what you type. Here are your
options:
1. All Entries: CheckBook Pro will use the Descriptions from all of your Entries.
2. The Last [user-speci ed] Entries: CheckBook Pro will use the Descriptions from a certain
number of your most recent Entries, instead of trying to nd matches using all of your
previous Descriptions.
3. The Following Items: Enter a list of Descriptions and CheckBook Pro will match only those
Descriptions.
Keep in mind the Descriptions CheckBook Pro nds when it AutoCompletes are for the kind of
Entry you're currently editing. Say you're working on a Deposit. With either of the rst two
options, CheckBook Pro will only try to AutoComplete using the Descriptions from your
previously entered Deposits. When you create your own list of Descriptions, however, you decide
which Description goes with each kind of Entry by putting your custom Descriptions in either the
Debits or Deposits section of the list.
Choose the third option and the list at the bottom of the sheet will become active so you can
enter your Descriptions. There are two sections in the list: Debits and Deposits. Click the name
of the section for the Descriptions you want to enter, then click the button with the plus symbol at
the bottom left of the list. A new, blank Description will appear, ready for you to type what you
want. Repeat these steps until all your desired Descriptions are in the list. If you make a mistake or
want to remove a Description, click it once, then click the button with the circular remove symbol
at the bottom left of the list. The selected Description will disappear.
Now that you've set up your Descriptions, repeat the same basic process in the To/From section.
Click the To/From button and let's continue.
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Account options: Click the To/From button.

To/From items
Here’s where you set up AutoCompletion for the To/From eld in each Entry, and it works just like
with Descriptions. If you pick the third option you’ll set up your To/From items in the list at the
bottom of the sheet. The only difference there is the section names have changed to To and From.
For items that show up when you're creating a Debit, select the To section and press the button
with the plus symbol at the bottom left of the list. For items that show up when you're creating a
Deposit, select the From section and press the button with the plus symbol at the bottom left of
the list. Edit the new items to suit. That's all there is to it!

To/From items

fi
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Almost there...
We’re almost done but there’s one important area left to cover. CheckBook Pro's Types.
Types make it easy to group your Entries by how they were transacted. For example, when you
spend you might use your debit card, cheques or cash, and when you receive funds you might
make a deposit or your employer may make a direct deposit. Like Descriptions and To/From items,
Types are also speci c to the kind of Entry you are working on - either Debit or Deposit. And,
Debit Types can be set to automatically change the current Entry into a Cheque. That comes in
handy if you also tell CheckBook Pro to number Cheques automatically. That way, when you
choose a Cheque Type the Entry will receive the next unused cheque number.
New Accounts come with a default set of Types, but you’re free to create some of your own.
There are so many possibilities and they're all up to you!
Click the Types button and let's move on to the Types section.

Account options: Click the Types button.

Almost there...
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Types
The Types section shows you a list of your Types, with buttons to add, edit and remove Types, and
an area where you can choose the default Type for Debits and the default Type for Deposits. Let's
look at the Types list rst.

Account options: Types

The Types list has the same buttons as the Descriptions and To/From lists. Add Types by pressing
the button with the plus symbol. Remove Types by pressing the button with the circular remove
symbol. Try creating a Type by clicking the button with the plus symbol. The Edit Type window will
appear.

Types

fi
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CheckBook Pro’s Edit Type window

Type the name of your new Type in the Type Name eld. Now, choose whether the Type is for
Debits or Deposits by clicking the button next to your choice. If your new Type is for Debits, and
you want it to automatically turn the current Entry into a Cheque, click the button to the left of
“Type is a Cheque”. Click the OK button and you've just created your rst Type. It's easy, and you
can create as many Types as you need.
To edit a Type, double-click it in the Types list, or click it once, then click the button with the pencil
symbol at the bottom left of the list. The Edit Type window will appear and you can make your
changes.
To remove a Type, click it once, then click the button with the circular remove symbol at the
bottom left of the list. It’ll disappear and that's that.
With a good list of Types, managing your Entries will be a walk in the park. Now, what if you could
choose a default Type for Debits and Deposits, so that you wouldn't have to select the Type as you
created new Entries? Keep reading!
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Types

fi

21

CheckBook Pro 2 Help

Account options: Default Types

Here you can see two menu buttons for choosing the default Type for Debits and Deposits. The
Types you select will be the defaults for all new Entries.
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A few tips...
To edit your Account settings later
Edit your Account settings at any time by going to the Account menu at the top of your screen,
then clicking the Edit Account... menu item. The same Account options sheet we've been working
in during this tutorial will appear.

Are Account passwords really necessary?
It depends, really. If you feel like you need to protect some Accounts and not others, you should
use a password for the Accounts you want to protect. If you’d rather have a single password for all
of your Accounts, it's a lot easier to use the Accounts Password option in the Security section in
CheckBook Pro's Preferences. If you use the Accounts Password be sure to turn off your Account
passwords so you’ll only have to enter one password when you open CheckBook Pro, instead of
each time you select an Account.

23
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Ready, set, go!
We've covered the basics of setting up your rst CheckBook Pro Account, but there's a lot left to
learn. When you press the OK button in the Account options sheet you'll have a blank Account
and the opportunity to discover how CheckBook Pro can help you take control of your nances.
Good luck!

Need More Info?
Visit Splasm's Contact Page and drop us a line. We'll be glad to help!
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Ready, set, go!
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Move from another personal nance app
About moving your data
When you’re just starting out with CheckBook Pro but have years of work in another personal
nance app, here're a few options for getting set up as quickly as possible:
• If you’re moving from Quicken Essentials for Mac or Quicken for Mac 2015 or later,
CheckBook Pro can create a new document with all of your Accounts: Create a new
document from a Quicken Essentials for Mac le or Create a new document from a Quicken
for Mac 2015 or later le.
• Open the application you’ve been using, go to its File menu, and look for an Export option. If
it can export to QIF or QMTF, open one of these les in CheckBook Pro and let it set up all
of your Accounts: Create a new document from a QIF or QMTF le.
• If a QIF or QMTF le isn’t available but you can export to tab-delimited text or CSV, or you
have data in an OFX or QFX le, create a CheckBook Pro document, set up your Accounts,
then import the data you need: Import from other personal nance apps or your bank.
Because each personal nance manager handles the ner details in its own way, these le formats
limit how much can be moved between applications. You can get accounts and many transaction
details, so you won't have to repeat the bulk of your work and your balances should be correct,
but items like schedules, reports, and some reconciliation data won’t be in the les exported from
any personal nance manager.

We're happy to help
Moving to a new application can take a little time and effort - and you're bound to have questions
along the way. If you need anything while you're getting started, you're welcome to contact us for
help moving your data into CheckBook Pro.
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Create a new document from a QIF or QMTF le
1. Open CheckBook Pro.
2. Go to the File menu at the top left of your screen, down to the New submenu, and click
the Document from QIF or QMTF… menu item. A window where you can choose a le
will appear.
3. Locate the le with your data, click it once, change the Text Encoding at the bottom of the
window as needed, then click the Open button at the bottom right of the window. The
Import Options window will appear:

The Import Options window
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Create a document from a QIF or QMTF le
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4. The default options should work well most of the time. In some locales, you may need to
change the Date Format, Decimal Separator, or Thousands Separator.
5. When you’re ready to continue, click the OK button at the bottom right of the window. A
window where you can name your new document and choose where to save it will appear.
6. Type a name in the Save As eld at the top of the window, choose a folder where you’d like
to save your Accounts document (we recommend the Documents folder in your Home
folder) and click the Create button at the bottom right of the window.
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Create a new document from a Quicken Essentials for Mac le
1. Open CheckBook Pro.
2. Go to the File menu at the top left of your screen, down to the New submenu, and click
the Document from Quicken Essentials… menu item. A window where you can choose a
le will appear.
3. Locate the le with your data - Quicken Essentials for Mac document names end with
".quickendata" - and double-click it, or click it once, then click the Open button at the
bottom right of the window. A window where you can name your new document and
choose where to save it will appear.
4. Type a name in the Save As eld at the top of the window, choose a folder where you’d like
to save your Accounts document (we recommend the Documents folder in your Home
folder) and click the Create button at the bottom right of the window.
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Create a document from a Quicken Essentials for Mac le
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Create a new document from a Quicken for Mac 2015 or later le
1. Open CheckBook Pro.
2. Go to the File menu at the top left of your screen, down to the New submenu, and click
the Document from Quicken for Mac 2015 or Later… menu item. A window where you
can choose a le will appear.
3. Locate the le with your data - Quicken for Mac 2015 or later document names end with
“.quicken" and may include a 4-digit year - and double-click it, or click it once, then click the
Open button at the bottom right of the window. A window where you can name your new
document and choose where to save it will appear.
4. Type a name in the Save As eld at the top of the window, choose a folder where you’d like
to save your Accounts document (we recommend the Documents folder in your Home
folder) and click the Create button at the bottom right of the window.
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Create a document from a Quicken for Mac 2015 or later le
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Import from other personal nance apps or your bank
About importing
CheckBook Pro understands data les in OFX, QFX, QIF, QMTF, CSV, tab-delimited text, Quicken
Essentials for Mac, and Quicken for Mac 2015 or later formats, giving you all the power you need
to import transactions from other personal nance apps or your online bank. If you're just starting
out with CheckBook Pro and migrating from Quicken Essentials for Mac or Quicken for Mac 2015
or later or an application that can export to QIF or QMTF, you’ll probably do better to move your
data to CheckBook Pro instead of importing the way we talk about in this section. Either way,
when you’re all set up, save time by downloading statement les from your online bank and
importing them into CheckBook Pro instead of entering each transaction by hand.

Get your data from most personal nance apps, like Quicken or Microsoft Money
1. Open the app.
2. Go to the File menu at the top left of your screen.
3. Look for the Export option or submenu. The options vary slightly by app. Export your data
to a QIF le, if possible. Otherwise, export your data to a CSV or tab-delimited text le.
4. Import the QIF le.

Download a statement le from your bank
1. Visit your bank’s website.
2. Go to the page where you can see your recent transactions.
3. Look for a Download or Export option. The options vary by bank. Download your data in
a QIF le, if possible. Otherwise, look for an OFX, QFX, CSV, or tab-delimited text option.
Your bank may have an MS Money option, which usually means an OFX le, or a Quicken option,
which usually means a QFX le. CheckBook Pro can import les in either format.

Import Entries from an OFX or QFX le
Import Entries and Categories from a QIF le
Import Entries and Categories from a Quicken Essentials le
Import Entries and Categories from a Quicken for Mac 2015 or later le
Import Entries from a tab-delimited text or CSV le
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Import OFX and QFX les
What is OFX?
Many online banks and credit card companies provide statements in the Open Financial Exchange
(OFX) le format. OFX les are a simple way to transfer transactions from one bank to another
or from the bank to your personal nance manager. Some banks also offer statements in the QFX
le format, which is closely related to OFX. CheckBook Pro can import les in either format. OFX
le names usually end in “.ofx” and QFX le names usually end in “.qfx”.

Import Entries from an OFX or QFX le
1. Go to the Account menu at the top of your screen, down to the Go to Account submenu,
and click the name of the Account you’d like to import into.
2. Go to the File menu at the top left of your screen, down to the Import submenu, and click
the OFX or QFX... menu item. A window where you can choose a le will appear.
3. In the window, locate the le you’d like to import, click it once, then click the Import button
at the bottom right of the window. The Import Options window will appear:
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CheckBook Pro’s OFX Import Options window

4. Now tell CheckBook Pro how to import your le.
• Click the Import Account menu button, then click the name of the Account you’d like to
import.
• Decide whether to import zero-amount Entries as Deposits or Debits.
• The options in the middle of the window help when data is in a different eld than
CheckBook Pro expects. Change where the data in these elds goes in CheckBook Pro
by looking for the eld name on the left and selecting the CheckBook Pro eld name
from the menu button on the right. For example, to put the data from each
transaction’s Memo eld into CheckBook Pro’s Description eld, click the menu button
to the right of Import Memos as and click the Descriptions item.
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• Turn on Find Duplicates to tell CheckBook Pro to identify potential duplicate incoming
transactions and not mark them for import. In general, leave Match Only by Date and
Amount and Match Only Imported Entries unchecked.
5. When you’re ready to continue, click the OK button at the bottom right of the window. A
preview of the Entries in the le will appear.

CheckBook Pro’s Import Preview window

6. Look closely at the Entries you’re about to import. If anything doesn’t look right, click the
Go Back button to change your Import Options. Place a checkmark next to each Entry
you’d like to keep and remove the checkmark next to each Entry you don’t want to keep.
Double-click an Entry to make changes.
7. When you’re ready to complete the import, click the OK button. Just to be safe,
CheckBook Pro will ask if you’re sure you want to continue. Click the Continue button and
the Entries with a checkmark will be added to the current Account.

If nothing happens after you choose a le to import
The le may not be in the OFX or QFX format. Here’s how to make sure:

fi
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1. Click the Finder icon in your Dock.
2. Find the le you’re trying to import.
3. Select the le with a single click so that it’s highlighted.
4. Go to the File menu at the top left of your screen and click the Get Info item. An Info
window will appear.
5. Look in the Name & Extension part of the Info window. If the last part of the le name is
not “ofx” or “qfx” the le probably isn’t an OFX or QFX le. Also, if the last part of the le
name is “qxf”, note this isn’t the same as “qfx”, so the le can’t be imported.
If you’re sure the le name ends in “ofx” or “qfx” contact us for help.

If some of the data in the Import Preview window isn’t in the right column
Try telling CheckBook Pro to put the data in a different column.
1. Note the column name where the wrong data appears. Which column should display that
kind of data?
2. Click the Go Back button at the bottom right of the Import Preview window. The Import
Options window will appear.
3. In the bottom section of the Import Options window, nd the column name you noted in
step 1 in the right-hand column of menu buttons. To the left is a label, like “Import Memos
as”. CheckBook Pro puts the left-hand type of data from the le into the right-hand eld in
each Entry. Click the menu button to change where the data from the le goes in your
Entries. If the option you click is already selected in another part of the right-hand column
it’ll be changed to an option that isn’t selected.
4. Click the OK button at the bottom right of the Import Options window when you’re ready
to continue. The Import Preview window will appear and you can continue reviewing the
Entries before nishing up.
If you try a few changes but data still isn’t in the right column contact us for help.

Tips
• Import Options are Account-speci c, so the settings you choose in one Account won’t
affect your other Accounts.
• Control-click anywhere in the list of Entries for a menu with common actions, such as
changing Category or Type, or marking an Entry for Import.
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Import QIF or QMTF les
What is QIF?
Many accounting apps and online banks provide easy access to your nancial information using QIF
les. QIF stands for Quicken Interchange Format. QIF le names usually end in “.qif ”, but you may
come across les with names that end in “.qmtf ”. CheckBook Pro can import these les with ease
and gives you several options for working with the many variations this format allows.

Import Entries and Categories from a QIF or QMTF le
1. Go to the Account menu at the top of your screen, down to the Go to Account submenu,
and click the name of the Account you’d like to import into.
2. Go to the File menu at the top left of your screen, down to the Import submenu, and click
the QIF or QMTF... menu item. A window where you can choose a le will appear.
3. In the window, locate the le you’d like to import, click it once, then click the Import button
at the bottom right of the window. The Import Options window will appear.
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CheckBook Pro’s QIF Import Options window

4. Now tell CheckBook Pro how to import your le.
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• Click the Import Account menu button, then click the name of the Account you’d like to
import. If the le doesn’t group transactions by Account, as many banks don’t, you’ll still
have an option to import all Entries.
• Click the Date Format menu button, then click the date format used in the le.
• If the le uses localised thousands and decimal symbols, enter these in the Decimal
Separator and Thousands Separator elds.
• Put a checkmark in the Import All Categories checkbox if you would like to import all
Categories in the le rather than only the Categories that are assigned to Entries.
• Decide whether to import zero-amount Entries as Deposits or Debits.
• The fourth set of options help when data is in a different eld than CheckBook Pro
expects. Change where the data in these elds goes in CheckBook Pro by looking for
the eld name on the left and selecting the CheckBook Pro eld name from the menu
button on the right. For example, to put the data from each transaction’s Memo eld
into CheckBook Pro’s Category eld, click the menu button to the right of Import
Memos as and click the Categories item.
• Turn on Find Duplicates to tell CheckBook Pro to identify potential duplicate incoming
transactions and not mark them for import. In general, leave Match Only by Date and
Amount and Match Only Imported Entries unchecked.
5. When you’re ready to continue, click the OK button at the bottom right of the window. A
preview of the Entries in the le will appear.
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CheckBook Pro’s Import Preview window

6. Look closely at the Entries you’re about to import. If anything doesn’t look right, click the
Go Back button to change your Import Options. Place a checkmark next to each Entry
you’d like to keep and remove the checkmark next to each Entry you don’t want to keep.
Double-click an Entry to make changes.
7. When you’re ready to complete the import, click the OK button. Just to be safe,
CheckBook Pro will ask if you’re sure you want to continue. Click the Continue button and
the Entries with a checkmark will be added to the current Account.

If nothing happens after you choose a le to import
The le may not be in the QIF or QMTF format. Here’s how to make sure:
1. Click the Finder icon in your Dock.
2. Find the le you’re trying to import.
3. Select the le with a single click so that it’s highlighted.
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4. Go to the File menu at the top left of your screen and click the Get Info item. An Info
window will appear.
5. Look in the Name & Extension part of the Info window. If the last part of the le name is
not “qif ” or “qmtf ”, the le probably isn’t a QIF or QMTF le.
If you’re sure the le name ends in “qif ” or “qmtf ”, contact us for help.

If some of the data in the Import Preview window isn’t in the right column
Try telling CheckBook Pro to put the data in a different column.
1. Note the column name where the wrong data appears. Which column should display that
kind of data?
2. Click the Go Back button at the bottom right of the Import Preview window. The Import
Options window will appear.
3. In the bottom section of the Import Options window, nd the column name you noted in
step 1 in the right-hand column of menu buttons. To the left is a label, like “Import Memos
as”. CheckBook Pro puts the left-hand type of data from the le into the right-hand eld in
each Entry. Click the menu button to change where the data from the le goes in your
Entries. If the option you click is already selected in another part of the right-hand column
it’ll be changed to an option that isn’t selected.
4. Click the OK button at the bottom right of the Import Options window when you’re ready
to continue. The Import Preview window will appear and you can continue reviewing the
Entries before nishing up.
If you try a few changes but data still isn’t in the right column contact us for help.

If the dates in the Import Preview window don’t look right
1. Click the Go Back button at the bottom right of the Import Preview window. The Import
Options window will appear.
2. Click the Date Format menu button to reveal a menu of different date formats. Click a
format you haven’t tried before.
3. Click the OK button at the bottom right of the Import Options window when you’re ready
to continue. The Import Preview window will appear and you can continue reviewing the
Entries before nishing up.

Tips
• Import Options are Account-speci c, so the settings you choose in one Account won’t
affect your other Accounts.
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• QIF les can vary by bank. Some banks place Categories in a le's Memo eld, or Payees or
To/From Items in a le's Category eld. The date format also varies. CheckBook Pro’s
Import Options help you get the best results with QIF les from the majority of sources.
Pay close attention to the way each Entry looks while still in the Import Preview window
and use the Go Back button to return to the Import Options window and tweak its settings
to match your QIF le. One gotcha: going back to the Import Options window will reset
any changes made in the Import Preview window.
• Control-click anywhere in the list of Entries for a menu with common actions, such as
changing Category or Type, or marking an Entry for Import.
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Import Quicken Essentials for Mac les
CheckBook Pro can import directly from a Quicken Essentials for Mac le. These les have names
that end in “.quickendata”.

Import Entries and Categories from a Quicken Essentials le
1. Go to the Account menu at the top of your screen, down to the Go to Account submenu,
and click the name of the Account you’d like to import into.
2. Go to the File menu at the top left of your screen, down to the Import submenu, and click
the Quicken Essentials for Mac... menu item. A window where you can choose a le will
appear.
3. In the window, locate the le you’d like to import and click it once. If the le looks like a
folder, open the folder and click the “data” le once. Click the Import button at the bottom
right of the window and the Import Options window will appear.

CheckBook Pro’s Quicken Essentials for Mac Import Options window

4. Now tell CheckBook Pro how to import your le.
• Click the Import Account menu button, then click the name of the Account you’d like to
import.
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• Put a checkmark in the Import All Categories checkbox if you’d like to import all
Categories in the Quicken Essentials for Mac le rather than only the Categories that
are assigned to Entries.
• Decide whether to import zero-amount Entries as Deposits or Debits.
5. When you’re ready to continue, click the OK button at the bottom right of the window. A
preview of the Entries in the le will appear.

CheckBook Pro’s Import Preview window

6. Look closely at the Entries you’re about to import. If anything doesn’t look right, click the
Go Back button to change your Import Options. Place a checkmark next to each Entry
you’d like to keep and remove the checkmark next to each Entry you don’t want to keep.
Double-click an Entry to make changes.
7. When you’re ready to complete the import, click the OK button. Just to be safe,
CheckBook Pro will ask if you’re sure you want to continue. Click the Continue button and
the Entries with a checkmark will be added to the current Account.

If nothing happens after you choose a le to import
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The le may not be in the Quicken Essentials for Mac format. Here’s how to make sure:
1. Click the Finder icon in your Dock.
2. Find the le you’re trying to import.
3. Select the le with a single click so that it’s highlighted.
4. Go to the File menu at the top left of your screen and click the Get Info item. An Info
window will appear.
5. Look in the Name & Extension part of the Info window. If the last part of the le name is
not “quickendata” the le probably isn’t a Quicken Essentials for Mac le.
If you’re sure the le name ends in “quickendata” contact us for help.

Tips
• Control-click anywhere in the list of Entries for a menu with common actions, such as
changing Category or Type, or marking an Entry for Import.
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Import Quicken for Mac 2015 or later les
CheckBook Pro can import directly from a Quicken for Mac 2015 or later le. These les have
names that end in “.quicken” and may include a 4-digit year.

Import Entries and Categories from a Quicken for Mac 2015 or later le
1. Go to the Account menu at the top of your screen, down to the Go to Account submenu,
and click the name of the Account you’d like to import into.
2. Go to the File menu at the top left of your screen, down to the Import submenu, and click
the Quicken for Mac 2015 or later… menu item. A window where you can choose a le
will appear.
3. In the window, locate the le you’d like to import and click it once. If the le looks like a
folder, open the folder and click the “data” le once. Click the Import button at the bottom
right of the window and the Import Options window will appear.

CheckBook Pro’s Quicken for Mac 2015 or later Import Options window

4. Now tell CheckBook Pro how to import your le.
• Click the Import Account menu button, then click the name of the Account you’d like to
import.
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• Put a checkmark in the Import All Categories checkbox if you’d like to import all
Categories in the Quicken for Mac 2015 or later le rather than only the Categories
that are assigned to Entries.
• Decide whether to import zero-amount Entries as Deposits or Debits.
5. When you’re ready to continue, click the OK button at the bottom right of the window. A
preview of the Entries in the le will appear.

CheckBook Pro’s Import Preview window

6. Look closely at the Entries you’re about to import. If anything doesn’t look right, click the
Go Back button to change your Import Options. Place a checkmark next to each Entry
you’d like to keep and remove the checkmark next to each Entry you don’t want to keep.
Double-click an Entry to make changes.
7. When you’re ready to complete the import, click the OK button. Just to be safe,
CheckBook Pro will ask if you’re sure you want to continue. Click the Continue button and
the Entries with a checkmark will be added to the current Account.

If nothing happens after you choose a le to import
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The le may not be in the Quicken for Mac 2015 or later format. Here’s how to make sure:
1. Click the Finder icon in your Dock.
2. Find the le you’re trying to import.
3. Select the le with a single click so that it’s highlighted.
4. Go to the File menu at the top left of your screen and click the Get Info item. An Info
window will appear.
5. Look in the Name & Extension part of the Info window. If the last part of the le name
doesn’t begin with “.quicken” the le probably isn’t a Quicken for Mac 2015 or later le.
If you’re sure last part of the le name begins with “.quicken” contact us for help.

Tips
• Control-click anywhere in the list of Entries for a menu with common actions, such as
changing Category or Type, or marking an Entry for Import.
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Import tab-delimited text or CSV les

What are tab-delimited text and CSV?
Tab-delimited text and CSV (comma-separated values) are simple le formats for storing all the
pieces that make up your transactions. Each piece, like a date or amount, is stored in what’s called
a “ eld”. CheckBook Pro can easily turn these elds into actual Entries you can work with later.
You can even tell CheckBook Pro where each eld should go when it makes each Entry.

Import Entries from a tab-delimited text or CSV le
1. Go to the Account menu at the top of your screen, down to the Go to Account submenu,
and click the name of the Account you’d like to import into.
2. Go to the File menu at the top left of your screen, down to the Import submenu, and click
the Text or CSV... menu item. A window where you can choose a le will appear.
3. In the window, locate the le you’d like to import, click it once, then click the Import button
at the bottom right of the window. The Import Options window will appear.
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CheckBook Pro’s Text Import Options window

4. Now tell CheckBook Pro how to import your le.
• The Data Layout section shows a row of menu buttons above a table of the raw data in
your le. Click each menu button, then click the name of the eld in CheckBook Pro
where you want to store the data in the column below the button. For example, if you
see dates in the rst column, or if you see the word “date” there, click the rst menu
button, then click the word “Date” in the menu. Do the same for all of the columns in
your le.
• Be sure to scroll the Data Layout to the right as far as possible and choose a
CheckBook Pro eld name for all the columns in your le.
• To skip a row of column names or rows that don’t appear to be actual transactions,
place a checkmark next to the Skip rst rows of data option, just below the Data Layout
table, and enter the number of rows you’d like to skip.
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• Click the Date Format menu button, then click the date format used in the le.
• If the amounts in the le have localised thousands and decimal symbols, enter these in
the Decimal Separator and Thousands Separator elds.
• Decide whether to import zero-amount Entries as Deposits or Debits.
• Turn on Find Duplicates to tell CheckBook Pro to identify potential duplicate incoming
transactions and not mark them for import. In general, leave Match Only by Date and
Amount and Match Only Imported Entries unchecked.
5. When you’re ready to continue, click the OK button at the bottom right of the window. A
preview of the Entries in the le will appear.

CheckBook Pro’s Import Preview window

6. Look closely at the Entries you’re about to import. If anything doesn’t look right, click the
Go Back button to change your Import Options. Place a checkmark next to each Entry
you’d like to keep and remove the checkmark next to each Entry you don’t want to keep.
Double-click an Entry to make changes.
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7. When you’re ready to complete the import, click the OK button. Just to be safe,
CheckBook Pro will ask if you’re sure you want to continue. Click the Continue button and
the Entries with a checkmark will be added to the current Account.

If nothing happens after you choose a le to import
The le may not be quite what CheckBook Pro expects. Contact us for help.

If some of the data in the Import Preview window isn’t in the right column
Try telling CheckBook Pro to put the data in a different column.
1. Note the column name where the wrong data appears. Which column should display that
kind of data?
2. Click the Go Back button at the bottom right of the Import Preview window. The Import
Options window will appear.
3. In the Data Layout section you’ll see a row of menu buttons above a table of the raw data
in your le. Click each menu button, then click the name of the eld in CheckBook Pro
where you want to store the data that appears in the column below that button. For
example, if you see dates in the rst column, or if you see the word “date” there, click the
rst menu button, then click the word “Date” in the menu. Do the same for all of the
columns in your le.
4. Click the OK button at the bottom right of the Import Options window when you’re ready
to continue. The Import Preview window will appear and you can continue reviewing the
Entries before nishing up.
If you try a few changes but data still isn’t in the right column contact us for help.

If the amounts in the Import Preview window don’t look right
1. Click the Go Back button at the bottom right of the Import Preview window. The Import
Options window will appear.
2. Look at the menu button above each column in the Data Layout at the top of the window.
•

If you're using the Amount setting, make sure only one column has been marked as
Amount and no other column has been marked as Positive Amount, Negative Amount,
or Flipped Amount.

•

If you're using the Positive Amount and Negative Amount settings, make sure only one
column has been marked as Positive Amount, only one column has been marked as
Negative Amount, and no column has been marked as Amount or Flipped Amount.
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•

If you're using the Flipped Amount setting, make sure only one column has been
marked as Flipped Amount and no other column has been marked as Amount, Positive
Amount, or Negative Amount.

•

Always set a balance or running balance column to Skip Field.

If the dates in the Import Preview window don’t look right
1. Click the Go Back button at the bottom right of the Import Preview window. The Import
Options window will appear.
2. Click the Date Format menu button to reveal a menu of different date formats. Click a
format you haven’t tried before.
3. Click the OK button at the bottom right of the Import Options window when you’re ready
to continue. The Import Preview window will appear and you can continue reviewing the
Entries before nishing up.

Tips
• When you import data that has split transactions, set one of the incoming text elds to act
as the Split Entry Parent ID. If this ID is unique to each parent transaction, and its split line
items have the same value in the same eld, when CheckBook Pro creates an actual Entry
from the data it should have the right split line items.
• Import Options are Account-speci c, so the settings you choose in one Account won’t
affect your other Accounts.
• Control-click anywhere in the list of Entries for a menu with common actions, such as
changing Category or Type, or marking an Entry for Import.
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Export your Entries
When you need to work with your Entries in another personal nance app, or send your data to
an accountant, CheckBook Pro gives you the tools to export your data to a QIF, tab-delimited text,
or CSV le, or even create a PDF le.

Export Entries to a QIF le
Export Entries to a tab-delimited text or CSV le
Create a PDF le
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Export a QIF le

1. Go to the File menu at the top left of your screen, then go to its Export submenu. Click the
QIF... menu item. A save window will appear.
2. Type a name for the exported le in the Export as eld at the top of the window.
3. Below the le name, choose a folder where you’d like to save the le.
4. Click the Export button in the bottom section of the window, then click what you’d like to
export.
• You can export a single Account, but you can also export all of your Accounts in a single
le if you click the All Accounts menu item.
• You won't be able to export Accounts that are locked. These Accounts will still be
visible in the Export popup menu so you can tell which will not be exported if you
select the All Accounts option.
5. If your Entries need a speci c date format, click the Date Format button, then click the
appropriate date format menu item.
6. If your Entries need to be in a speci c text encoding, click the Text Encoding button, then
click the appropriate text encoding menu item. The local text encoding is selected by
default.
7. Click the Export button at the bottom right of the window.

Notes
A QIF le is not the same as a data backup. To create a backup, copy your Accounts document to
a backup drive as necessary.
When exporting the current search results, note that only Split Line Items that match the current
search options will be included in the exported data. This could affect the total of the exported
data.
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Export a tab-delimited text or CSV le

1. Go to the File menu at the top left of your screen, then go to its Export submenu. Click the
Text or CSV... menu item. A save window will appear.
2. Type a name for the exported le in the Export as eld at the top of the window.
3. Below the le name, choose a folder where you’d like to save the le.
4. Choose whether to export tab-delimited text or CSV.
5. Click the Export menu button in the bottom section of the window, then click what you’d
like to export.
• You can export a single Account, but you can also export all of your Accounts in a single
le if you click the All Accounts menu item.
• You won't be able to export Accounts that are locked. These Accounts will still be
visible in the Export popup menu so you can tell which will not be exported if you
select the All Accounts option.
6. If your Entries need a speci c date format, click the Date Format button, then click the
appropriate date format menu item.
7. If your Entries need to be in a speci c text encoding, click the Text Encoding button, then
click the appropriate text encoding menu item. The local text encoding is selected by
default.
8. Click the Export button at the bottom right of the window.

Notes
A text le is not the same as a data backup. To create a backup, copy your Accounts document to
a backup drive as necessary.
When exporting the current search results, note that only Split Line Items that match the current
search options will be included in the exported data. This could affect the total of the exported
data.
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Create a PDF le

1. Go to the File menu at the top left of your screen, then click the Print... menu item. A print
window will appear.
2. Click the PDF button at the bottom left corner of the window, then click the Save as PDF...
menu item. A save sheet will appear.
3. Type a name for the PDF le in the Save As eld at the top of the sheet.
4. Click the Save button at the bottom right of the window.
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Manage your Entries
About the Entry section
Most of what you’ll do in CheckBook Pro happens in the Entry section, where you manage and
browse your Entries.

The Entry section

The Entry section’s powerful toolbar allows you to:
• Create new Deposits and Debits
• Browse, change and remove existing Entries
• Search for Entries
• Show and hide the Accounts drawer
Entries for today’s date and before appear in the full Deposits and Debits colours. Entries for
future dates appear fainter. Transfers are italicised.
Look for the Interactive Balance at the bottom right of the window. It’s a great way to keep an eye
any one of several vital statistics, updated in real time as you work in your Accounts.
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If your Entries aren’t in the right order
1. Click the title of the column you would like to sort by, such as the Date column. The
column header should become highlighted.
2. Click the column header a second time to reverse the sort order.

If some or all of your Entries are missing
1. Go to the top right of the window and click the magnifying glass icon at the left side of the
search eld. A menu will appear.
2. Click the last item in the menu, Clear All Search Options.
3. Make sure a Smart Folder is not selected by going to the Account menu at the top of your
screen, down to the Go to Account submenu and clicking the name of the current Account.
You can also click the name of the current Account in the Accounts drawer at the right or
left side of the document window.

If a column is missing
1. Go to the View menu at the top of your screen, down to the Columns submenu and, if the
missing column name does not have a checkmark, click the column name. The column will
be added to the far right of the Entry list.
2. Resize the document window, if necessary, by dragging its bottom right corner to suit.
3. Resize any columns, if necessary, by placing the mouse cursor over the separator between
the column headers, so that the cursor becomes a small double-ended arrow. Drag the
separator to suit.
Also consider gathering or resetting your columns.

If a column isn’t the right width
Place your mouse cursor over the separator between the column headers, so that the cursor
becomes a small double-ended arrow. Drag the separator to suit or simply double-click it to
automatically resize it to t the contents of the column.

If a column isn’t in the right place
Place your mouse over the column header, drag it left or right to the desired location and drop.

About the Entry section
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If you often scroll to the right to see the rest of your columns
Go to the View menu at the top of your screen, down to the Columns submenu, and click the
Gather Columns menu item. Your columns will be resized to try to t the document window. This
only affects the current view in the Account you’re working in.

To reset the columns in your current view
Go to the View menu at the top of your screen, down to the Columns submenu, and click the
Reset Columns… menu item. The default columns will appear with their original widths. This only
affects the current view in the Account you’re working in.

If your Entry details are too small or too big, or if you’d like a different font
1. Go to the CheckBook Pro menu at the top left corner of your screen and click the
Preferences… menu item. The Preferences window will appear.
2. Look for the Entry Font and Size settings a little over halfway down the window.

If you want different colors for your Deposits and Debits
1. Go to the CheckBook Pro menu at the top left corner of your screen and click the
Preferences… menu item. The Preferences window will appear.
2. Look for the Deposits Color and Debits Color settings near the top of the window.

If you want to see a different balance or total at the bottom right of the window
Learn how to set the Interactive Balance.

If you want separate columns for Deposit and Debit amounts
1. Go to the View menu at the top of your screen, down to the Columns submenu, and, if the
Deposit menu item does not have a checkmark, click the Deposit menu item. The Deposit
column will be added to the far right of the list of Entries.
2. Go to the View menu at the top of your screen, down to the Columns submenu, and, if the
Debit menu item does not have a checkmark, click the Debit menu item. The Debit column
will be added to the far right of the list of Entries.
3. Go to the View menu at the top of your screen, down to the Columns submenu, and, if the
Amount menu item has a checkmark, click the Amount menu item. The Amount column
will be removed from the list of Entries.
About the Entry section
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Tips
• Control-click or right-click in the list of Entries for a menu with common actions, such as
changing Category or Type, or marking an Entry as Resolved or Tax-deductible. These
actions can also be performed in the Entry menu at the top of your display.
• Column ordering and widths are Account-speci c, so the layout you create in one Account
won’t affect your other Accounts.

About the Entry section
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Create an Entry
1. Go to the Account menu at the top of your screen, then go to its Go to Account submenu.
Click the name of the Account where you’d like to create an Entry.
2. Click the Entry button at the bottom of the document window.
3. Click the Debit or Deposit button, at the top left of the document window. An Entry sheet
will appear.
4. Enter the details for the new Entry.
5. Click the OK button and the new Entry will be added to the current Account.

Tips
• Use these keyboard shortcuts to create an Entry:
• Command + - for a new Debit
• Command + = for a new Deposit
• You can also create new Entries by going to the Entry menu at the top of your screen and
clicking the New Debit... or New Deposit... items. The same options are also available by
Control-clicking or right-clicking anywhere in the list of Entries.

60

Create a new Entry

CheckBook Pro 2 Help

Change one or more Entries
1. Go to the Account menu at the top of your screen, then go to its Go to Account submenu.
Click the name of the Account with the Entries you’d like to change.
2. Click the Entry button at the bottom of the document window.
3. Select the Entries you want to change. A single click selects a single Entry, Shift-clicking an
Entry selects a contiguous group of Entries and Command-clicking an Entry adds it to the
current selection.
4. Click the Change button, at the top left of the document window. A sheet will appear.
5. Change the details in the sheet.
6. Click the OK button and your changes will be applied to the selected Entries.

Tips
• Press the Return key or Enter key on your keyboard to begin changing the selected Entries.
• Double-click the selected Entries to begin changing them. If a single Entry is selected,
CheckBook Pro will select the double-clicked data so you can begin changing it immediately.
• You can also change Entries by going to the Entry menu at the top of your screen and
clicking the Change Entry... item. The same option is also available by Control-clicking or
right-clicking the selection.
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Remove one or more Entries
1. Go to the Account menu at the top of your screen, then go to its Go to Account submenu.
Click the name of the Account with the Entries you’d like to remove.
2. Click the Entry button at the bottom of the document window.
3. Select the Entries you want to remove. A single click selects a single Entry, Shift-clicking an
Entry selects a contiguous group of Entries and Command-clicking an Entry adds it to the
current selection.
4. Click the Remove button, at the top of the document window. By default, you’ll be asked
whether you’re certain you’d like to remove the selected Entries.
5. Click the OK button and the selected Entries will be removed.

Note
When you attempt to remove a Transfer Entry you’ll be asked for permission to remove the
corresponding Entry from the other Account.

Tips
• Press the Delete key on your keyboard to remove the selected Entries.
• You can also remove Entries by going to the Entry menu at the top of your screen and
clicking the Remove Entry... item. The same option is also available by Control-clicking or
right-clicking the selection.
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Transfer funds between Accounts
CheckBook Pro makes it easy to transfer funds between your Accounts. Create an Entry, tell it
which Account to transfer to or from and a matching Entry will automatically be created in the
other Account. Changes to one Entry will automatically be applied to the other.

1. Go to the Account menu at the top of your screen, down to the Go to Account submenu,
and click the name of the Account you’d like to transfer to or from.
2. Click the Entry button at the bottom of the document window.
3. Click the Transfer button at the top of the document window, then click the New Deposit
Transfer… or New Debit Transfer… menu item. An Entry sheet will appear.
4. Enter the details for the new Entry. When you get to the To Account or From Account
menu button, click the button and choose the Account to transfer to or from.
5. Click the OK button to complete the new Entry. A matching Entry will automatically appear
in the To Account or From Account.

Tips
• When transferring funds between Accounts with different Currencies, you’ll see the
Exchanged As eld below the Amount eld, where you can enter the actual Amount to
transfer to or from the other Account. Click the Currency Exchange Helper button to the
right of this eld for help calculating the right exchanged Amount.
• Transfers are italicised in the Entry and Reconcile sections.

Transfer funds between Accounts
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Move Entries between Accounts
Use drag & drop to move Entries between Accounts, but be careful because there's no way to
undo the move. If your Entries end up in the wrong Account you'll need to remove them by hand.
And while drag & drop is the easiest way, read on for steps to move Entries with copy & paste.

To copy and paste Entries between Accounts
1. Go to the Account menu at the top of your screen, then go to its Go to Account submenu.
Click the name of the Account with the Entries you’d like to copy.
2. Click the Entry button at the bottom of the document window.
3. Select the Entries you want to copy. A single click selects a single Entry, Shift-clicking an
Entry selects a contiguous group of Entries, and Command-clicking an Entry adds it to the
current selection.
4. Go to the Edit menu at the top of your screen and click the Copy menu item.
5. Go to the Account menu at the top of your screen, then go to its Go to Account submenu.
Click the name of the Account where you’d like to paste the copied Entries.
6. Go to the Edit menu at the top of your screen and click the Paste menu item.

To remove the Entries from their original Account
7. Go to the Account menu at the top of your screen, then go to its Go to Account submenu.
Click the name of the Account you visited in step 1.
8. Select the Entries you copied in step 3.
9. Click the Remove button at the top of the document window.

Notes
Pasting or moving resolved or reconciled Entries may change the resolved balance or reconciled
status of an Account, and pasted or moved Entries that transfer to or from the target Account will
need to lose their transfer details or they won't make much sense. CheckBook Pro will give you a
heads up if it thinks you're in either situation so you can decide how to proceed.

Tips
• You can drag & drop or copy & paste to another application that accepts text or HTML table
data, such as TextEdit, Numbers, or Excel.
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Move Entries to a Folder
Use CheckBook Pro’s Folders when you need to organise Entries, perhaps by calendar year, or
move older Entries out of the way without completely removing them from your document.

1. Click the Entry button at the bottom of the document window.
2. If the Accounts drawer is not visible to the right or left of the document window, click the
Accounts button at the top right of the document window.
3. Go to the Accounts drawer and click the name of the Account with the Entries you’d like to
move to a Folder.
4. Go to the Accounts drawer and click the triangle to the left of the selected Account’s icon
to reveal its Folders and Smart Folders.
5. Select the Entries you want to move. A single click selects a single Entry, Shift-clicking an
Entry selects a contiguous group of Entries and Command-clicking an Entry adds it to the
current selection.
6. Drag your selection to the appropriate Folder. If you need a new Folder, learn how to
create a Folder.

Tips
• Learn how to create a Folder.
• Folder contents are still included in the parent Account’s balance.
• Account Summaries include only the Entries in the selected Folder.
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Types
CheckBook Pro’s Types allow you to group Entries by how they were transacted. For example, you
may use a cheque or cash to pay for items at the store. Assigning Entries a Cheque or Cash Type
makes it easier to nd all Cheque or Cash payments later.
CheckBook Pro Accounts come with several built-in Types. You can change or remove these, or
add some of your own, in the Types section in the Account options sheet. The changes you make
in the Types section are Account-speci c.

Account options: Types
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You can even set up your Types so that when one is selected in a Debit Entry it also becomes a
Cheque - enabling the Cheque # eld. If the Number Cheques Automatically option is enabled in
CheckBook Pro’s Preferences, when you assign a Type con gured for Cheques to an Entry the next
available cheque number is automatically inserted into the Cheque # eld.
You can also set the default Deposit and Debit Entry Types in the Account options sheet's Types
section. New Entries will automatically be assigned the appropriate default Type.

Tips
• Control-click or right-click the selected Entries to see a menu that contains an option for
setting their Type directly.
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Splits
When you’d like to account for multiple sources of cash ow in a single Entry, CheckBook Pro
refers to this as a Split Entry.

An Entry’s Split section

After changing a Split Entry’s Line Items, their sum becomes the Amount for that Entry.

If you want to see Split Line Items in the Entry or Reconcile sections
Click the triangle to the left of a Split Entry to show or hide its Split Line Items.

If you’d like to show or hide all Split Line Items in the Entry or Reconcile sections
Click any Entry once, go to the Edit menu at the top of your screen, click the Select All menu item,
then press the right or left arrow key on your keyboard.

To include both positive and negative Split Line Items in the same Entry
Splits

fl

68

CheckBook Pro 2 Help

Enter a dash or hyphen (-) before a Split Line Item’s Amount and the Amount will count against
the total Split Entry Amount. In a Split Debit, placing a dash before a Split Line Item’s Amount will
credit that amount toward the Entry’s Amount. In a Split Deposit, placing a dash before a Split Line
Item’s Amount will deduct that amount from the Entry’s Amount.

Tips
• Empty elds in a Split Line Item inherit their value from the parent Entry. For example, if the
Category for the parent Entry is “Groceries” and the Category for one of its Split Line Items
is blank, that Split Line Item’s Category will be considered “Groceries” in search and Account
Summary operations.
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The Interactive Balance
The Interactive Balance is at the bottom right of the Entry section.

The Interactive Balance

The Interactive Balance allows you to keep an eye on any one of a number of key Account
statistics, updated in realtime as you work in the currently selected Account. The following options
are available:
• Balance: shows the balance for all Entries plus the current Account's Starting Balance.
• Today's Balance: shows the balance for all Entries through today plus the current Account's
Starting Balance.
• Search Total: shows the total for all Entries in the Entry list. Only Split Line Items that
match the current search options will be included in the total. If you have no search options
set and no Smart Folder selected, the total for all Entries without the Starting Balance is
shown.
• Selection Total: shows the total for the selected Entries. Only Split Line Items that match
the current search options will be included in the total.
• Resolved Total: shows the total for all Resolved Entries.
• Unresolved Total: shows the total for all Unresolved Entries.
70
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• Deposits Total: shows the total for all Deposit Entries.
• Debits Total: shows the total for all Debit Entries.
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Set the Interactive Balance
1. Click the Entry button at the bottom of the document window.
2. Click the Balance eld’s label, where you’ll see a small triangle, just to the left of the Balance
eld. A menu will appear.
3. Click the appropriate Interactive Balance option.
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Speaking Entries
CheckBook Pro can help you review your Real World statements by reading them aloud to you.
Tell CheckBook Pro to speak each Entry as you select it, or to begin speaking all Entries, either
from the top of the list or from the currently selected Entry. You can also set how long CheckBook
Pro pauses between spoken Entries.

Turn on Speaking Entries and Speaking Amounts
1. Go to the CheckBook Pro menu at the top left of your screen and click the Preferences...
item. The Preferences sheet will appear.
2. Click the Entry button at the top of the Preferences sheet.
3. Change the Speaking options to suit.
4. Click the OK button to con rm your changes.

Speaking Entries
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Find Entries
CheckBook Pro gives you two powerful tools to quickly nd the Entries and Split Line Items that
match a given set of criteria: a search eld and Smart Folders. The search eld and its various
search criteria make it a snap to nd just what you’re looking for. Smart Folders take it to the next
level, letting you save groups of advanced search criteria you can use now and in the future.
In the Entry and Reconcile sections, Entries are rst ltered through the selected Smart Folder,
then they’re ltered with the current search options. In the Summary section, Entries are ltered
through the selected Smart Folder rst, then they’re ltered with the selected Account Summary’s
Filter options.
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Searching
Look to the top right corner of the Entry and Reconcile sections and you’ll nd CheckBook Pro's
search eld. Click the magnifying glass icon at the left side of the eld to see a list of criteria to
choose from. The rst two groups of criteria tell CheckBook Pro how to use what you type into
the search eld. Click any of these criteria, then type something into the search eld and
CheckBook Pro will display only the items with matching details. The rest of the criteria are used in
addition to your selection in the rst groups. Use any combination of options to nd just the
Entries you’re interested in. The active options are displayed right below the search eld.
Every Account in CheckBook Pro has its own search options for both the Entry and Reconcile
sections. This way you can set up a work ow that perfectly matches each Account.

CheckBook Pro’s Search Options
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About search options
• General: searches the Type, Category, Description, To/From and Notes elds of each Entry.
Split Line Items are also searched. Note that when a single Split Line Item matches then the
entire parent Entry and its Split Line Items are considered a match.
• Description: searches the Description eld of each Entry and Split Line Item.
• To/From: searches the To/From eld of each Entry and Split Line Item.
• Type: searches the Type eld of each Entry.
• Category: searches the Category eld of each Entry and Split Line Item.
• Notes: searches the Notes eld of each Entry.
• Cheque Number: searches the cheque number eld in each Entry.
• Amount: searches the Amount eld of each Entry and Split Line Item.
• Today: shows any Entries created on Today's date.
• Yesterday: shows any Entries created on Yesterday's date.
• Through Today: shows any Entries created on or before the current date.
• This Week: shows any Entries created during the current calendar week.
• This Month: shows any Entries created during the current calendar month.
• This Quarter: shows any Entries created during the current calendar quarter. Quarters
run from January 1 through March 31, April 1 through June 30, July 1 through September 30,
and October 1 through December 31.
• This Year: shows any Entries created during the current calendar Year.
• This Week To Date: shows any Entries created during the current calendar week, through
the current day.
• This Month To Date: shows any Entries created during the current calendar month,
through the current day.
• This Quarter To Date: shows any Entries created during the current calendar quarter,
through the current day. Quarters run from January 1 through March 31, April 1 through
June 30, July 1 through September 30, and October 1 through December 31.
• This Year To Date: shows any Entries created during the current calendar year, through the
current day.
• Last Week: shows any Entries created during the previous calendar week.
• Last Month: shows any Entries created during the previous calendar month.
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• Last Quarter: shows any Entries created during the previous calendar quarter. Quarters
run from January 1 through March 31, April 1 through June 30, July 1 through September 30,
and October 1 through December 31.
• Last Year: shows any Entries created during the previous calendar year.
• All Dates: effectively disables searching by date.
• Resolved: shows any Entries that are marked as Resolved.
• Unresolved: shows any Entries that are not marked as Resolved.
• Tax-Deductible: shows any Tax-Deductible Entries.
• Taxable: shows any Taxable Entries.
• Reconciled: shows any Reconciled Entries.
• Unreconciled: shows any Unreconciled Entries.
• Both: effectively disables searching by the group of options immediately above the Both
option.
• Clear All Search Options: resets all search options.
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Find Entries with the search eld
1. Click the Entry or Reconcile button at the bottom of the document window.
2. Click the magnifying glass icon at the left side of the search eld at the top right of the
document window. A menu will appear.
3. Click the desired options in the menu. The rst two groups of options are designed to
work together with whatever you type into the search eld, so you can search speci c Entry
elds. The rest of the options let you search for Entries based on certain preset date ranges,
a custom date range or the Resolved, Tax-Deductible or Reconciled status of each Entry.

Tips
• The active search options are displayed right below the search eld. These options are all
active at the same time, so you can really narrow your search. Here’s an example: If you
want to nd all the Entries for groceries for the current year, select both the Description
option and the This Year option, then type the word “groceries” into the search eld.
• When you start using CheckBook Pro, your search options are automatically saved to the
current Accounts document when you close it and restored the next time you open the
same document. This makes it easy to pick up where you left off later. Change this
preference by toggling the "Save Search Options When Switching Accounts" checkbox in the
General section in CheckBook Pro’s preferences. When this checkbox doesn’t have a
checkmark, all search options will be cleared each time you close an Accounts document.
• Also by default, when you add or change an Entry, the current search options are re-applied.
Since a new or changed Entry’s data might not match the current search options, it could
end up hidden. You can change this preference by changing the "After Changing Entries"
setting in the Entry section in CheckBook Pro’s preferences.
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Reset or clear search options
1. Click the Entry or Reconcile button at the bottom of the document window.
2. Click the magnifying glass icon at the left side of the search eld at the top right of the
document window, then click the Clear All Search Options item.

Reset Search Options
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Smart Folders
When you need to work with more advanced sets of search criteria, and particularly when you
plan to re-use the same criteria in the future, look to CheckBook Pro’s Smart Folders. A Smart
Folder is a group of Conditions, similar to the options in the search eld, but with far more options
and possible combinations. Your Entries and Split Line Items are ltered through these Conditions
one at a time and all Conditions must be met for an Entry or Split Line Item to match. Each new
Account comes with This Year and Last Year Smart Folders, but you can create as many of your
own as you can think of.
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Find Entries with a Smart Folder
1. Click the Entry or Reconcile button at the bottom of the document window.
2. Click the Accounts button at the top right corner of the document window to reveal the
Accounts drawer.
3. Click the triangle to the left of the appropriate Account to reveal its Smart Folders.
4. Click the appropriate Smart Folder. To create a Smart Folder go to the Account menu at
the top of your screen and click the “New Smart Folder...” menu item.

Tips
• Smart Folders remain selected between CheckBook Pro sessions. Keep this in mind if you
don’t see all the Entries in the selected Account.
• In the Entry and Reconcile sections your Entries are ltered through both the selected
Smart Folder and the current search options.
• In the Summary section Entries are ltered through both the selected Smart Folder and the
selected Account Summary’s Filter options.
• Rearrange your Smart Folders using drag and drop.
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Reconcile your Accounts
What is Reconciliation?
Reconciliation is comparing your Entries with what your bank or nancial institution says has
posted, so you can count on CheckBook Pro’s totals and balances. Enter your statement’s ending
balance, nd each transaction on the statement in CheckBook Pro and mark them as Resolved,
and, when your Unreconciled total reaches zero, click the Reconcile button to lock the Amount
and Resolved status of your Reconciled Entries so you won’t have to go over them again.

The Reconcile section

Before you reconcile, let’s talk about some key terms and parts of the process.
Resolved means you’ve noted an Entry in CheckBook Pro appears on a paper statement from
your bank or in a list of transactions on a web page, and the Amount in CheckBook Pro matches
the amount on the statement, so the affect on your actual, Real World balance is re ected in
CheckBook Pro’s Resolved Balance. Mark an Entry as Resolved by putting a checkmark in its
Resolved checkbox.
Reconciled means the Resolved Entries in your Account have, on a particular date, been checked
against a statement and their total matched that statement’s ending balance. Complete a
reconciliation in CheckBook Pro by clicking the small Reconcile button at the bottom right of the
Reconcile section. Every Resolved Entry’s Amount and Resolved checkbox is then locked so these
Entries won’t ever differ from the statement.
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In short, mark Entries as Resolved to tell CheckBook Pro they’ve posted, reconcile to tell
CheckBook Pro the Resolved Entries add up to a particular statement’s ending balance, and
CheckBook Pro saves your work so you won’t have to redo anything later.
Now, click the Reconcile button at the bottom of the window to reveal the Reconcile section,
where you'll work with CheckBook Pro to reconcile your Account.
Look for the Statement column at the bottom right corner of the window, with elds for
Statement Balance, Resolved Balance, and Unreconciled. The numbers in the Statement column
have to be just right so you can completely reconcile:
Statement Balance is the ending balance from your statement. Think of it as the total of every
transaction the bank knows has posted.
Resolved Balance is the total of all the Entries you’ve marked as Resolved, plus the Account’s
Starting Balance.
Unreconciled is the difference between the Statement Balance and the Resolved Balance.
If you've reconciled this Account before, your last reconciliation date and balance appear below the
Account column. A green dot with a checkmark means your last reconciliation is still valid. A red
stop sign means something about your Account has changed so that your last reconciliation isn’t
valid anymore. Learn why a previous reconciliation may not be valid.
That covers the basics. Tackle a reconciliation and let us know if you need a hand along the way!

Reconcile your Accounts
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Reconcile against a statement
1. Click the Reconcile button at the bottom of the document window.
2. If you've reconciled this Account before, look for a status message about your last
reconciliation below the Account column, near the bottom of the window. The message
tells you when you last reconciled and the balance as of that reconciliation. If you see a
green dot with a checkmark to the left of the message, your last reconciliation is still valid, so
you can continue. If you see a red stop sign to the left of the message, something about
your Account has changed so that your last reconciliation is no longer valid. Learn why a
previous reconciliation may not be valid before you continue.
Once your last reconciliation is valid, compare the statement’s opening balance with the
balance of your last reconciliation. If these don't match, make sure the statement is for the
period immediately after your last reconciliation.
If you haven’t reconciled this Account before, the Account’s Starting Balance must be
correct before you can reconcile. If you began creating Entries from the beginning of a
speci c statement period, enter the statement’s opening balance as the Account's Starting
Balance. If you began creating Entries in the middle of a statement period, enter the
statement’s opening balance plus the total of the transactions before the rst transaction
you entered into CheckBook Pro as the Account's Starting Balance. Learn how to change
an Account's Starting Balance.
3. Type the ending balance from your statement in the Statement Balance eld, near the
bottom right of the window, at the top of the Statement column. If you're reconciling a
credit card Account, you'll almost always enter the statement’s ending balance as a negative
number.
4. Beginning with the rst transaction on the statement, nd the corresponding Entry in
CheckBook Pro and make sure the Amount in CheckBook Pro matches the transaction
amount. If the Entry doesn’t appear in CheckBook Pro, create one for the transaction.
Mark the Entry as Resolved. Repeat this step with the rest of the transactions on the
statement.
5. When the Unreconciled total reaches zero the Reconcile button near the bottom right of
the document window will be enabled. Click the Reconcile button and the Amounts in all
Resolved Entries will be locked so they can't be changed. Learn how to reconcile when the
Unreconciled total doesn't reach zero.

If the Unreconciled total doesn’t reach zero
To reconcile, the Statement Balance and Resolved Balance must be the same. When they’re
different, the Unreconciled total is not zero. That means the data in CheckBook Pro is somehow
different from your statement. You’ll need to nd the differences in CheckBook Pro and correct
them:
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• Make sure the Statement Balance matches the ending balance from your statement. Watch
out for credit card statements. They can show a positive balance, but, as long as you owe,
you’ll want to enter that as a negative amount.
• Reset the Resolved status for all unreconciled Entries by going to the Account menu at the
top of your screen and clicking the “Reset Unreconciled Entries...” menu item, then try to
reconcile again.
• As you compare the transactions on your statement with the Entries in CheckBook Pro,
make sure the negative transactions appear as Debits and the positive transactions appear
as Deposits.

If you want to see only Unreconciled Entries
Use the Unreconciled option in the search options menu at the top right of the window.

If you need to start over from the beginning of your statement
Click the Reset Unreconciled Entries button near the bottom right of the window. All
unreconciled Entries will be marked as Unresolved.

If you need to change the Amount or the Split Line Items in a Reconciled Entry
1. Click the Reconcile button at the bottom of the document window.
2. Go to the Account menu at the top of your screen and click the “Unreconcile...” menu item.
3. Make changes as necessary.
Keep in mind that if you change an Entry’s Amount or its Split Line Items your Resolved Balance
may be different from the last Statement Balance. It’s up to you to make the numbers work so you
can reconcile again.

If your previous reconciliation isn’t valid
When a red stop sign appears before your last reconciliation’s status message, below the Account
column, the total of your Reconciled Entries doesn’t match the total of your last reconciliation.
That means one or more Reconciled Entries have been removed or the Account’s Starting Balance
has changed. Here’s how to x that before you begin your next reconciliation:
1. Enter the amount of your last reconciliation, from the reconciliation status message below
the Account column, in the Statement Balance eld.
2. If the Reset Unreconciled Entries button, below the Statement column, is available, click it,
then click the OK button. All Unreconciled Entries will be marked as Unresolved.
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3. Note the Unreconciled total at the bottom of the Statement column. This is the difference
between the last reconciliation and the total of what’s been reconciled. In other words, you
need to account for the Unreconciled total so your Account can be reconciled.
4. If you know the Account’s Starting Balance has changed, and that change accounts for the
Unreconciled total, go to the Account menu, click the Edit Account... menu item, and change
the Starting Balance to what is displayed plus the Unreconciled total you noted earlier. For
example, if the Starting Balance is $100.00 and the Unreconciled total is $42.00, change the
Starting Balance to $142.00. Click the OK button and the Resolved Balance should now
match the Statement Balance. Click the Reconcile button below the Statement column and
you're ready for your next reconciliation.
5. If you’re certain the Account's Starting Balance hasn’t changed, the most likely reason the
last reconciliation isn’t valid is one or more Reconciled Entries have been removed. If you
can gure out which Entries were removed, create new Entries to match. If you’re not sure
what to do, create a single Entry for the Unreconciled total you noted earlier. Mark your
new Entries as Resolved and your Resolved Balance should equal the Statement Balance.
Click the Reconcile button below the Statement column and you're ready for your next
reconciliation.
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Schedule repeating Entries
CheckBook Pro's Schedules let you set up Entries that repeat, like utilities or paycheques, and show
you when the next Entry will be created. The Schedule Reminder shows you a list of any
Scheduled Entries that are due so you can approve them.

The Schedule section

Click the Schedule button at the bottom of the document window to see the Schedule section.
Like the Entry and Reconcile sections, you can drag columns by their column header to rearrange
them, click any column header to sort by that column, change sort order, access a contextual menu
by Control-clicking or right-clicking, and more.

Tips
• When CheckBook Pro creates a new Entry from a Schedule for a particular date, the
Schedule won’t create another Entry for that date ever again. That means if you remove a
Scheduled Entry from the Entry or Reconcile section, another Scheduled Entry for that
Schedule for the same date won’t appear in the Schedule Reminder, as if you skipped the
Scheduled Entry. If you’d like another Entry for that date, you’ll need to create it by hand.
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Create a Schedule
1. Go to the Account menu at the top of your screen, then go to its Go to Account submenu.
Click the name of the Account where you’d like to create a Schedule.
2. Click the Schedule button at the bottom of the document window.
3. Click the Debit or Deposit button, at the top left of the document window. A Schedule
sheet will appear.
4. Enter the details for the new Schedule.
5. Click the Schedule button at the top right of the sheet to set how the Schedule repeats.
6. Click the OK button and the new Schedule will be added to the current Account.

Tips
• Use these keyboard shortcuts to create a Schedule:
• Command + Option + - for a new Debit Schedule
• Command + Option + = for a new Deposit Schedule
• You can also create new Schedules by going to the Schedule menu at the top of your
screen and clicking the New Debit Schedule... or New Deposit Schedule... items. The same
options are also available by Control-clicking or right-clicking anywhere in the list of Entries.
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Change a Schedule
1. Go to the Account menu at the top of your screen, then go to its Go to Account submenu.
Click the name of the Account with the Schedule you’d like to change.
2. Click the Schedule button at the bottom of the document window.
3. Click the Schedule you want to change.
4. Click the Change button, at the top left of the document window. A Schedule sheet will
appear.
5. Change the Schedule’s details.
6. Click the OK button and your changes will be applied to the Schedule.

Tips
• Press the Return key or Enter key on your keyboard to begin changing the selected
Schedule.
• Double-click a Schedule to begin changing the Schedule. If possible, CheckBook Pro will
select the double-clicked data so you can begin changing it immediately.
• You can also change Schedules by going to the Schedule menu at the top of your screen
and clicking the Change Schedule... item. The same option is also available by Controlclicking or right-clicking a Schedule.
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Remove a Schedule
1. Go to the Account menu at the top of your screen, then go to its Go to Account submenu.
Click the name of the Account with the Schedule you’d like to remove.
2. Click the Schedule button at the bottom of the document window.
3. Click the Schedule you want to remove.
4. Click the Remove button, at the top of the document window. You’ll be asked whether
you’re certain you’d like to remove the selected Schedule.
5. Click the OK button and the selected Schedule will be removed.

Tips
• Press the Delete key on your keyboard to remove the selected Schedule.
• You can also remove Schedules by going to the Schedule menu at the top of your screen
and clicking the Remove Schedule... item. The same option is also available by Controlclicking or right-clicking the selection.
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See Scheduled Entries
The Schedule Reminder appears when Scheduled Entries are due. Commit, skip or remove any of
the Scheduled Entries using the buttons along the top of the Schedule Reminder. The Schedule
Reminder Balance, at the bottom right corner of the Schedule Reminder, shows you several
different totals and balances, just like the Interactive Balance.

The Schedule Reminder

Show the Schedule Reminder
Go to the Schedule menu at the top of your screen, then click the Scheduled Entries menu item.

Commit, skip, or permanently remove a Scheduled Entry
1. Go to the Account menu at the top of your screen, then go to its Go to Account submenu.
Click the name of an Account with Scheduled Entries that are due.
2. Go to the Schedule menu at the top of your screen, then click the Scheduled Entries menu
item. The Schedule Reminder will appear.
3. Scheduled Entries that are due through today’s date are set to commit by default. Click a
Scheduled Entry, then click the Commit button at the top left of the Schedule Reminder to
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toggle the Scheduled Entry's Commit status. To permanently remove the selected
Scheduled Entry, click the Remove button at the top of the Schedule Reminder.
4. Click the OK button when you’re certain you’d like to Commit or Skip the Scheduled
Entries that remain in the list. Any Scheduled Entries you may have removed from the list
will be permanently skipped. If you’re unsure, or would like to cancel, click the Later button
at the bottom left of the Schedule Reminder.

The Schedule Reminder Balance
The Schedule Reminder Balance gives you four different totals and balances:
• Commit Balance: The current Account’s balance plus the sum of the Scheduled Entries that
are about to be committed.
• Scheduled Balance: The current Account’s balance plus the sum of all Scheduled Entries
that appear in the Schedule Reminder, even those that are not about to be committed.
• Commit Total: The sum of all the Scheduled Entries that are about to be committed.
• Scheduled Total: The sum of all Scheduled Entries that appear in the Schedule Reminder.

Change the Description, To/From, or Amount of a Scheduled Entry before it’s committed
Double-click the eld you’d like to change. The To/From and Amount of a Scheduled Entry with
Split Line Items, and the To/From for a Scheduled Entry that transfers to or from another Account,
can’t be changed.

Set how long CheckBook Pro waits before it automatically shows the Schedule Reminder
Click the Remind button at the bottom left of the Schedule Reminder, then click the amount of
time you’d like CheckBook Pro to wait before it automatically shows the Schedule Reminder.
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Forecast with Look Ahead
Occasionally, you’ll want to see which Scheduled Entries are right around the corner and how
they’ll affect your Balance. Look Ahead, near the bottom left of the Schedule Reminder, helps you
do just that with easy controls for how many days, weeks, months or years to look into the future.

Schedule Reminder: Look Ahead

Tips
• Look Ahead won’t mark any future Scheduled Entries as ready to Commit. That’s up to you.
• Removing future Scheduled Entries can’t be undone, but change a Look Ahead setting and
the removed Scheduled Entries will reappear.
• Changes to future Scheduled Entries aren’t saved if the Entries aren’t committed.
• The Schedule Reminder Balance updates on-the- y as you change the Look Ahead settings.
You’ll get a fair estimate of your future Account Balance if most of your Debits and Deposits
are set up as Schedules.

Forecast with Look Ahead
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Manage your Accounts
The Accounts drawer
Easily manage all of your Accounts, Folders and Smart Folders in the Accounts drawer, attached to
the right or left of the document window.

The Accounts drawer
94
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The Accounts drawer shows your Accounts, their balances, Folders and Smart Folders, a total of all
unlocked Accounts, and buttons for adding, editing and removing Accounts, Folders and Smart
Folders. When an Account is protected by a password, a lock icon will appear instead of the
balance, and its Folders and Smart Folders will be hidden, until the Account is unlocked.

Show the Accounts drawer
Click the Accounts button at the top right of the document window to show the Accounts drawer.

Switch the Accounts drawer to the other side of the window
Hold the Option (⌥) key on your keyboard while you click the Accounts button at the top right
of the document window.

Move an Account above or below another Account
Click and drag the Account above or below the other Account.

Show or hide an Account’s Folders and Smart Folders
Click the triangle just to the left of the Account’s icon.

Move a Folder above or below another Folder
Click and drag the Folder above or below the other Folder.

Move a Smart Folder above or below another Smart Folder
Click and drag the Smart Folder above or below the other Smart Folder.

If a lock icon appears next to an Account
The Account is protected by a password. Click the Account and you’ll be asked for its password.
Enter the password and its balance, Folders and Smart Folders will appear.

Tips
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• You can also add, edit and remove Accounts, Folders and Smart Folders by going to the
Account menu at the top of your screen. The same options are also available by rightclicking or Control-clicking anywhere in the list of Accounts.

Display today’s balances and totals
Go to the View menu at the top of your screen, down to Accounts Drawer, and click the Through
Today menu item.
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Create an Account
1. Click the Accounts button at the top right of the document window to show the Accounts
drawer.
2. Click the New button at the bottom of the Accounts drawer, then click the New Account...
item. The Account options sheet will appear.
3. Enter the details for the new Account.
4. Click the OK button and the new Account will be added to the current document.

Tips
• You can also create new Accounts by going to the Account menu at the top of your screen
and clicking the New Account... item. The same option is also available by Control-clicking
or right-clicking anywhere inside the Accounts list.
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Edit an Account
1. Click the Accounts button at the top right of the document window to show the Accounts
drawer.
2. Click the Account you want to edit.
3. Click the Edit button at the bottom of the Accounts drawer. The Account options sheet will
appear.
4. Change the Account's details.
5. Click the OK button and your changes will be applied to the Account.

Tips
• You can also edit Accounts by going to the Account menu at the top of your screen and
clicking the Edit Account... item. The same option is also available by Control-clicking or
right-clicking an Account in the Accounts list.
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Remove an Account
1. Click the Accounts button at the top right of the document window to show the Accounts
drawer.
2. Click the Account you want to remove.
3. Click the Remove button at the bottom of the Accounts drawer. You will be asked to
con rm you would like to remove the Account. If the document has only one Account, it
can’t be removed.
4. Click the OK button to remove the Account, or click the Cancel button to leave the
Account as-is.

Tips
• You can also remove Accounts by going to the Account menu at the top of your screen and
clicking the Remove Account... item. The same option is also available by Control-clicking or
right-clicking an Account in the Accounts list.
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Create a Smart Folder
1. Click the Accounts button at the top right of the document window to show the Accounts
drawer.
2. Click the Account for your new Smart Folder.
3. Click the New button at the bottom of the Accounts drawer, then click the New Smart
Folder... item. The Smart Folder Options sheet will appear.
4. Enter the details for the new Smart Folder.
5. Click the OK button and the new Smart Folder will be added to the current Account.

Tips
• You can also create new Smart Folders by going to the Account menu at the top of your
screen and clicking the New Smart Folder... item. The same option is also available by
Control-clicking or right-clicking an Account in the Accounts list.
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Edit a Smart Folder
1. Click the Accounts button at the top right of the document window to show the Accounts
drawer.
2. Click the Smart Folder you want to edit.
3. Click the Edit button at the bottom of the Accounts drawer. The Smart Folder Options
sheet will appear.
4. Change the Smart Folder’s details.
5. Click the OK button and your changes will be applied to the Smart Folder.

Tips
• You can also edit Smart Folders by going to the Account menu at the top of your screen
and clicking the Edit Smart Folder... item. The same option is also available by Controlclicking or right-clicking a Smart Folder in the Accounts list.
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Remove a Smart Folder
1. Click the Accounts button at the top right of the document window to show the Accounts
drawer.
2. Click the Smart Folder you want to remove.
3. Click the Remove button at the bottom of the Accounts drawer. You’ll be asked to con rm
you would like to remove the Smart Folder.
4. Click the OK button to remove the Smart Folder, or click the Cancel button to leave the
Smart Folder as-is.

Tips
• You can also remove Smart Folders by going to the Account menu at the top of your
screen and clicking the Remove Smart Folder... item. The same option is also available by
Control-clicking or right-clicking a Smart Folder in the Accounts list.

Remove a Smart Folder
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Create a Folder
1. Click the Accounts button at the top right of the document window to show the Accounts
drawer.
2. Click the Account for your new Folder.
3. Click the New button at the bottom of the Accounts drawer, then click the New Folder...
item. The Folder Options sheet will appear.
4. Enter the details for the new Folder.
5. Click the OK button and the new Folder will be added to the current Account.

Tips
• You can also create new Folders by going to the Account menu at the top of your screen
and clicking the New Folder... item. The same option is also available by Control-clicking or
right-clicking an Account in the Accounts list.
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Edit a Folder
1. Click the Accounts button at the top right of the document window to show the Accounts
drawer.
2. Click the Folder you want to edit.
3. Click the Edit button at the bottom of the Accounts drawer. The Folder Options sheet will
appear.
4. Change the Folder’s details.
5. Click the OK button and your changes will be applied to the Folder.

Tips
• You can also edit Folders by going to the Account menu at the top of your screen and
clicking the Edit Folder... item. The same option is also available by Control-clicking or rightclicking a Folder in the Accounts list.
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Remove a Folder
1. Click the Accounts button at the top right of the document window to show the Accounts
drawer.
2. Click the Folder you want to remove.
3. Click the Remove button at the bottom of the Accounts drawer. You’ll be asked to con rm
you would like to remove the Folder.
4. Click the OK button to remove the Smart Folder, or click the Cancel button to leave the
Folder as-is.

Tips
• You can also remove Folders by going to the Account menu at the top of your screen and
clicking the Remove Folder... item. The same option is also available by Control-clicking or
right-clicking a Folder in the Accounts list.

Remove a Folder
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Hide an Account
When you need a little extra elbow room and have an Account you don’t use often or you’d like
to move out of the way, why not hide it? Hidden Accounts can always be shown again, so let’s
organise!
1. Click the Accounts button at the top right of the document window to show the Accounts
drawer.
2. Click the Account you want to hide.
3. Click the Edit button at the bottom of the Accounts drawer. The Account options sheet will
appear.
4. Remove the checkmark next to Show Account in the bottom half of the sheet.
5. Click the OK button.

Tips
• To show or hide your hidden Accounts, go to the View menu at the top of your screen,
down to Accounts Drawer, and click the Show Hidden Accounts or Hide Hidden Accounts
menu item. You’ll see a similar option in the Accounts drawer.
• Hidden Accounts are included in All Accounts unless you also remove the checkmark next
to Include in All Accounts before you click the OK button.
• If you need to go a step further and close an Account, click here.
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Close an Account
When you close an Account in the Real World, here’s how to keep it around so its gures still
appear in All Accounts.
1. Click the Accounts button at the top right of the document window to show the Accounts
drawer.
2. Click the Account you want to close.
3. Bring the Account down to a zero balance as you would in the Real World. You might
transfer its remaining funds to another Account or simply create an Entry in the opposite
amount of the current balance.
4. Click the Edit button at the bottom of the Accounts drawer. The Account options sheet will
appear.
5. Remove the checkmarks next to Show Account and Enable Schedules in the bottom half of
the sheet. You’ll probably want to keep a checkmark next to Include in All Accounts.
6. Click the OK button.

Tips
• If you only need to hide an Account, click here.

Close an Account
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Create a trial Account
When you want to test out some ideas, create a trial Account and experiment. It can't hurt!
1. Click the Accounts button at the top right of the document window to show the Accounts
drawer.
2. Click the New button at the bottom of the Accounts drawer, then click the New Account...
item. The Account options sheet will appear.
3. Enter the details for the new Account.
4. Remove the checkmarks next to Include in All Accounts and Enable Schedules in the
bottom half of the sheet.
5. Click the OK button and the new Account will be added to the current document.
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Account options: Account
The Account section in the Account options lets you change an Account's name, icon, starting
balance, and Currency.

Account options: Account

Change the name of an Account
1. Go to the Account menu at the top of your screen and click the Edit Account... menu item.
The Account options sheet will appear.
2. Change the Account Name near the top of the sheet.

Change the icon of an Account
1. Go to the Account menu at the top of your screen and click the Edit Account... menu item.
The Account options sheet will appear.
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2. Click the Icon button under the Account Name eld. A menu of icons will appear.
3. Click an icon in the menu, or click the Choose... menu item at the bottom of the menu and
select an image le.
You can also drag an icon from your Desktop into the Icon button, or paste an image into the Icon
button when the button is in focus.
If you use one of your own images, make sure the image is twice as wide as it is tall, and a minimum
of 128 pixels wide.

Change the starting balance of an Account
1. Go to the Account menu at the top of your screen and click the Edit Account... menu item.
The Account options sheet will appear.
2. Change the amount in the Starting Balance eld near the middle of the sheet.

Change the Currency of an Account
1. Go to the Account menu at the top of your screen and click the Edit Account... menu item.
The Account options sheet will appear.
2. Click the Currency button near the middle of the sheet, then click the Currency you’d like
to use in the Account.

Hide or show an Account
1. Go to the Account menu at the top of your screen and click the Edit Account... menu item.
The Account options sheet will appear.
2. Click the Show Account button in the bottom half of the sheet.

Exclude or include an Account in All Accounts
1. Go to the Account menu at the top of your screen and click the Edit Account... menu item.
The Account options sheet will appear.
2. Click the Include in All Accounts button in the bottom half of the sheet.

Disable or enable an Account’s Schedules
1. Go to the Account menu at the top of your screen and click the Edit Account... menu item.
The Account options sheet will appear.
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2. Click the Enable Schedules button in the bottom half of the sheet.
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Account options: Descriptions
The Descriptions section in the Account options lets you set up how CheckBook Pro
autocompletes Descriptions in Entries and Scheduled Entries.

Account options: Descriptions

Change how Descriptions are autocompleted
1. Go to the Account menu at the top of your screen and click the Edit Account... menu item.
The Account options sheet will appear.
2. Click the Descriptions button at the top of the sheet.
3. Choose one of the following options:
• All Entries: Descriptions from all Entries.
• The Last user-speci ed number Entries: Descriptions from a speci c number of the
most recently changed Entries.
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• The Following Items: The list at the bottom of the sheet is enabled, with buttons below
so you can add, edit, and remove Descriptions. Click the button at the bottom right of
the list to import Descriptions from another Account.
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Account options: To/From
The To/From section in the Account options lets you set up how CheckBook Pro autocompletes
To/From items in Entries and Scheduled Entries.

Account options: To/From

Change how To/From items are autocompleted
1. Go to the Account menu at the top of your screen and click the Edit Account... menu item.
The Account options sheet will appear.
2. Click the To/From button at the top of the sheet.
3. Choose one of the following options:
• All Entries: To/From items from all Entries.
• The Last user-speci ed number Entries: To/From items from a speci c number of the
most recently changed Entries.
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• The Following Items: The list at the bottom of the sheet is enabled, with buttons below
so you can add, edit, and remove To/From items. Click the button at the bottom right of
the list to import To/From items from another Account.
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Account options: Types
Types describe how Entries were transacted, like ATM withdrawals or cheques. They can also be
set to automatically put a checkmark in a Debit Entry's Cheque # checkbox and to automatically
assign the Entry the next available cheque number.

Account options: Types
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Create a Type
1. Go to the Account menu at the top of your screen, then go to its Go to Account submenu.
Click the name of the Account where you’d like to create a Type.
2. Go to the Account menu at the top of your screen, then click the Edit Account... item. The
Account options sheet will appear.
3. Click the Types button at the top of the Account options sheet.
4. Click the Add button at the bottom left of the Types list. The Add button has a plus icon.
An Edit Type window will appear.
5. Enter the name for the new Type.
6. Choose an Entry kind for the new Type, either Deposits or Debits.
7. If the new Type is for Debits, and you would like assigning it to an Entry to automatically
make the Entry a Cheque, click the Type is a Cheque checkbox.
8. Click the OK button and the new Type will be added to the current Account.

Tips
• Click the button at the bottom right of the list to import Types from another Account.
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Edit a Type
1. Go to the Account menu at the top of your screen, then go to its Go to Account submenu.
Click the name of the Account with the Type you’d like to edit.
2. Go to the Account menu at the top of your screen, then click the Edit Account... item. The
Account options sheet will appear.
3. Click the Types button at the top of the Account options sheet.
4. Click the Type you want to edit.
5. Click the Edit button at the bottom left of the Types list. The Edit button has a pencil icon.
An Edit Type window will appear.
6. Change the Type's details.
7. Click the OK button and your changes will be applied to the Type.
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Remove a Type
1. Go to the Account menu at the top of your screen, then go to its Go to Account submenu.
Click the name of the Account with the Type you’d like to remove.
2. Go to the Account menu at the top of your screen, then click the Edit Account... item. The
Account options sheet will appear.
3. Click the Types button at the top of the Account options sheet.
4. Click the Type you want to remove.
5. Click the Remove button at the bottom left of the Types list. The Remove button has an
icon of a circle with a line through it.
6. Click the OK button and the Type will be permanently removed, or click the Cancel button
to leave your Types unchanged.
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Set the default Types for an Account
1. Go to the Account menu at the top of your screen, then go to its Go to Account submenu.
Click the name of the Account where you’d like to set the default Types.
2. Go to the Account menu at the top of your screen, then click the Edit Account... item. The
Account options sheet will appear.
3. Click the Types button at the top of the Account options sheet.
4. Click the Default Debit Type button or the Default Deposit Type button near the bottom of
the sheet, then click the name of the Type you’d like to use as the default Type.
5. Click the OK button, or click the Cancel button to leave the default Types unchanged.
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Account options: Security

Account options: Security

Change the optional Account password
1. Go to the Account menu at the top of your screen and click the Edit Account... menu item.
The Account options sheet will appear.
2. Click the Security button at the top of the Account options sheet.
3. Enter a password in the Account Password eld.
4. Re-enter the password, with the same capitalisation, in the Re-type Password eld.

If CheckBook Pro won’t accept your password
Try typing your password carefully, with the same capitalisation as when you rst set the password.
You could also try any other passwords you might have set as the Account password.
If neither of those ideas work, click the Forgot Password? button at the bottom left of the
password sheet to reset all the passwords in your Accounts document. You’ll be led through
sending a Challenge code to our support team. During regular business hours you should receive
a Response code within a couple of hours.

Are my passwords and data encrypted?
Your passwords are always encrypted in your Accounts document, but the data is not. OS X can
encrypt all of your data automatically with the FileVault feature. To control FileVault, go to the
Apple menu at the top left of your screen, click the System Preferences... menu item. The System
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Preferences window will appear. Type the word “FileVault” in the search eld at the top right of the
window.

Account options: Security
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Track cash ow over time
See detailed information about your Accounts, including Category subtotals, over any time period
with Account Summaries.

The Account Summary section

Create your own Account Summaries for speci c date ranges, with subtotals of your Deposits and
Debits by day, week, month, quarter or year. Set your Account Summaries to display Entries that
are Resolved vs. Unresolved, Tax-Deductible vs. Taxable, and Cheques vs. Non-Cheques. You can
even search for your Entries with the standard General, Description, Type, To/From, and Notes
search options. When your Account Summaries are set up just right you can print them, too.

View an Account Summary
Create an Account Summary
Print an Account Summary

Track cash ow over time
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View an Account Summary
1. Go to the Account menu at the top of your screen, then go to its Go to Account submenu.
Click the name of the Account with the Account Summary you’d like to view.
2. Click the Summary button at the bottom of the document window.
3. Click the name of the Account Summary you’d like to view in the list near the upper left of
the window. The Account Summary will appear in the large area to the right.
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Create an Account Summary
1. Go to the Account menu at the top of your screen, then go to its Go to Account submenu.
Click the name of the Account with the Account Summary you’d like to view.
2. Click the Summary button at the bottom of the document window.
3. Click the New button at the top left of the document window. A Summary Options sheet
will appear.
4. Enter the details for the new Account Summary.
5. Click the OK button and the new Account Summary will be added to the current Account.

Tips
• You can also create new Account Summaries by going to the Summary menu at the top of
your screen and clicking the New Account Summary... menu item. The same option is also
available by Control-clicking or right-clicking anywhere the list of Account Summaries.
• In some cases, Account Summaries may be set up so that there’s no data to populate parts
of each subtotal period. For instance, if you choose to display only Debits, data for Deposits
won’t appear in the Account Summary.
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Change an Account Summary
1. Go to the Account menu at the top of your screen, then go to its Go to Account submenu.
Click the name of the Account with the Account Summary you’d like to change.
2. Click the Summary button at the bottom of the document window.
3. Click the name of the Account Summary you’d like to change in the list near the upper left
of the window.
4. Click the Change button at the top of the document window. A Summary Options sheet
will appear.
5. Change the Account Summary's details.
6. Click the OK button and your changes will be applied to the Account Summary.

Tips
• Tap the Return or Enter keys on your keyboard to begin changing the current Account
Summary.
• You can also change Account Summaries by going to the Summary menu at the top of your
screen and clicking the Change Account Summary... item. The same option is also available
by Control-clicking or right-clicking the name of an Account Summary in the list near the
upper left of the window.
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Remove an Account Summary
1. Go to the Account menu at the top of your screen, then go to its Go to Account submenu.
Click the name of the Account with the Account Summary you’d like to remove.
2. Click the Summary button at the bottom of the document window.
3. Click the name of the Account Summary you’d like to remove in the list near the upper left
of the window.
4. Click the Remove button at the top of the document window.

Tips
• Tap the Delete key on your keyboard to remove the current Account Summary.
• You can also remove Account Summaries by going to the Summary menu at the top of your
screen and clicking the Remove Account Summary... item. The same option is also available
by Control-clicking or right-clicking the name of an Account Summary in the list near the
upper left of the window.
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Print an Account Summary
1. Go to the Account menu at the top of your screen, then go to its Go to Account submenu.
Click the name of the Account with the Account Summary you’d like to print.
2. Click the Summary button at the bottom of the document window.
3. Click the name of the Account Summary you’d like to print in the list near the upper left of
the window.
4. Click the Print button at the top of the document window, or go to the File menu and click
the Print... item. A print window will appear.
5. Set up the print job options, then click the Print button at the bottom right of the window.
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All Accounts
CheckBook Pro’s All Accounts section gives you an easy way to see and summarise the Entries
from all of your Accounts at once. It’s also where you’ll manage your Categories and Currencies.
To access the All Accounts section, click the All Accounts item in the Accounts drawer or go to the
Accounts menu at the top of your screen, then go to its Go to Account submenu and click the All
Accounts item.
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Create a Category
1. Go to the Account menu at the top of your screen, then click the Edit All Accounts... menu
item. The All Accounts Options sheet will appear.
2. Click the Categories button at the top of the sheet.
3. Click the Add button at the bottom left of the list of Categories. The Add button has a plus
icon. A new Category will be added to the list.
4. Enter the name for the new Category.
5. Click the OK button to save your changes, or click the Cancel button to leave the
Categories list unchanged.

Tips
• To create a subcategory, drag and drop one Category onto another Category.

Create a Category while changing an Entry
1. Create an Entry or begin changing an Entry.
2. Click in the Category eld.
3. Enter a name for the new Category. To create subcategories, separate each Category from
the next with a colon (“:”). For example, “Auto:Fuel”.
4. Click the OK button and the new Category will be added to the current document.

Create a Category
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Edit a Category
1. Go to the Account menu at the top of your screen, then click the Edit All Accounts... menu
item. The All Accounts Options sheet will appear.
2. Click the Categories button at the top of the sheet.
3. Double-click the Category you’d like to edit.
4. Enter the new name for the Category.
5. Click the OK button and your changes will be applied to the Category, or click the Cancel
button to leave your Categories unchanged.
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Remove a Category
1. Go to the Account menu at the top of your screen, then click the Edit All Accounts... menu
item. The All Accounts Options sheet will appear.
2. Click the Categories button at the top of the sheet.
3. Click the Category you’d like to remove.
4. Click the Remove button at the bottom left of the Categories list. The Remove button has
an icon of a circle with a line through it. If the selected Category is in use in any Entries
you’ll be given an opportunity to substitute another Category.
5. Click the OK button and your changes will be applied to the Category, or click the Cancel
button to leave your Categories unchanged.
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Create a Currency
1. Go to the Account menu at the top of your screen, then click the Edit All Accounts... menu
item. The All Accounts Options sheet will appear.
2. Click the Currencies button at the top of the sheet.
3. Click the Add button at the bottom left of the Currencies list. The Add button has a plus
icon. An Edit Currency sheet will appear.
4. Enter the new Currency’s details.
5. Click the OK button and the new Currency will be added to the Currencies list, or click the
Cancel button to leave the Currencies list unchanged.
6. Click the OK button at the bottom right of the sheet to save your Currencies, or click the
Cancel button to leave your Currencies unchanged.
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Edit a Currency
1. Go to the Account menu at the top of your screen, then click the Edit All Accounts... menu
item. The All Accounts Options sheet will appear.
2. Click the Currencies button at the top of the sheet.
3. Click the name of the Currency you’d like to edit.
4. Click the Edit button at the bottom left of the Currencies list. The Edit button has a pencil
icon. An Edit Currency sheet will appear.
5. Edit the Currency’s details.
6. Click the OK button and your changes will be applied to the Currency, or click the Cancel
button to leave the Currency unchanged.
7. Click the OK button at the bottom right of the sheet to save your Currencies, or click the
Cancel button to leave your Currencies unchanged.
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Remove a Currency
1. Go to the Account menu at the top of your screen, then click the Edit All Accounts... menu
item. The All Accounts Options sheet will appear.
2. Click the Currencies button at the top of the sheet.
3. Click the name of the Currency you’d like to remove.
4. Click the Remove button at the bottom left of the Currencies list. The Remove button has
an icon of a circle with a line through it.
5. Click the OK button at the bottom right of the sheet and the Currency will be permanently
removed, or click the Cancel button to leave your Currencies unchanged.
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Share and sync your data
Sharing data
CheckBook Pro stores your Accounts in a document le, so it’s easy to make changes on your Mac
and send the document to another Mac over your network or take it with you on a thumb drive.
If you make changes on the other Mac just copy the document back to your Mac.
You can also store your Accounts document in a cloud storage folder, such as DropBox or Google
Drive. Just make sure only one Mac at a time accesses the document, and that the cloud storage
service isn’t uploading or downloading the document when you open or close it.

Syncing data
With CheckBook Pro, you can periodically sync your data - merge your changes - with CheckBook
Pro (or its little brother, CheckBook) running on another Mac on the same network. And, if you’re
using OS X Mountain Lion or later and purchase CheckBook Pro from the Mac App Store, you can
automatically sync with other devices using iCloud’s Documents in the Cloud feature.

Share and sync your data
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Sync with CheckBook Pro (or CheckBook) on the same network
1. On both Macs, open CheckBook Pro (or CheckBook).
2. On both Macs, open the Accounts document you want to sync.
3. On both Macs, go to the File menu at the top left of the screen and click the Sync... menu
item. A Sync window will open on each Mac.
4. On just one Mac, click the name of the other Mac in the Sync window, then click the Sync
button at the bottom right of the window.
5. If you’re prompted, enter the Passcode displayed in the Sync window on the other Mac.

If there’s a problem syncing CheckBook Pro on the same network
• Make sure both Macs can go to splasm.com.
• If you see an error message, copy and paste the entire message in an email to
support@splasm.com.
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Move your Accounts to iCloud
Move your Accounts to iCloud Drive on OS X Yosemite and later
1. Make sure you’re signed into iCloud. You can sign into iCloud by going to the Apple menu
at the top left of your screen, clicking the System Preferences... item, clicking the iCloud
preference pane icon and signing in at the left side of the window.
2. Make sure iCloud Drive is enabled in the iCloud preferences pane in System Preferences.
You can enable iCloud Drive by going to the Apple menu at the top left of your screen,
clicking the System Preferences... item, clicking the iCloud preference pane icon and putting a
checkmark next to the iCloud Drive item.
3. Open your Accounts document in CheckBook Pro.
4. Go to the File menu at the top left of your screen and click the Move To... item. A sheet will
appear at the top of the document window.
5. Click the menu button in the sheet, then click the iCloud Drive menu item.

Move your Accounts to iCloud on OS X Mountain Lion and OS X Mavericks
On OS X Mountain Lion and OS X Mavericks, iCloud is only available when CheckBook Pro is purchased
from the Mac App Store.
1. Make sure you’re signed into iCloud. You can sign into iCloud by going to the Apple menu
at the top left of your screen, clicking the System Preferences... item, clicking the iCloud
preference pane icon and signing in at the left side of the window.
2. Make sure Documents & Data is enabled in the iCloud preferences pane in System
Preferences. You can enable Documents & Data by going to the Apple menu at the top left
of your screen, clicking the System Preferences... item, clicking the iCloud preference pane
icon and putting a checkmark next to the Documents & Data item.
3. Open your Accounts document in CheckBook Pro.
4. Go to the File menu at the top left of your screen and click the Move To... item. A sheet will
appear at the top of the document window.
5. Click the menu button in the sheet, then click the iCloud menu item.

If you’re using iCloud or other cloud storage and changes made on one Mac don’t appear in
CheckBook on another Mac
• Make sure both Macs can go to splasm.com.
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• On both Macs, make sure CheckBook Pro has the same document open. You can check the
path to the document by Command-clicking or right-clicking the name of the document at
the top of the window. For iCloud, the path will simply be “iCloud/Document Name”. The
path could be different for other cloud storage folders, but should usually end the same way,
ie. “DropBox/Document Name” or “Google Drive/Document Name”.
• On both Macs, make sure iCloud or your cloud storage service is enabled.
• On OS X Yosemite and later, check the status of the iCloud Drive service at http://
www.apple.com/support/systemstatus/. If it’s not green, Apple will resolve the issue as soon
as possible.
• On OS X Mountain Lion and OS X Mavericks, check the status of the Documents in the
Cloud service at http://www.apple.com/support/systemstatus/. If it’s not green, Apple will
resolve the issue as soon as possible.
• Restart both Macs.
• If you see an error message, copy and paste the entire message in an email to
support@splasm.com.
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Print cheques
When you’re ready to write cheques, let CheckBook Pro do the heavy lifting. You can print to
standard, pre-printed 3-up personal or wallet cheque paper, as well as to pre-printed single-cheque
voucher cheque paper. If you don’t nd a template you need, get in touch at support@splasm.com
and we’ll see what we can do!

Print cheques
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Print cheques from an Account
1. Go to the Account menu at the top of your screen, down to the Go to Account submenu,
and click the name of the Account with the Entries you’d like to print as cheques. Cheques
can’t be printed from the All Accounts section.
2. Go to the File menu and click the Print Cheques… menu item. A window where you can
select the Entries to print as cheques will appear.
3. By default, the window will display all Debits with actual amounts dated during the previous
two months and into the future. Adjust what’s displayed with the Look Back and Show
controls at the bottom left of the window.
4. Enter the cheque number from the rst paper cheque you’ll be printing in the Starting
Cheque # eld.
5. Place a checkmark in the Print column next to each Entry you’d like to print.
6. To set an address for a cheque, click the Address eld of its Entry. The next time you print
cheques, the same address will automatically be assigned to Entries with the same To.
7. When you’re ready to continue, click the Print… button at the bottom right of the window.
A standard print panel will appear.
8. Click the Template button, then click the name of the template that matches your preprinted cheque paper.
9. If the rst sheet of cheque paper you’ll be printing to isn’t a full sheet, place a checkmark
next to the First Page is option, then click the number button just to the right of that and
click the appropriate number of cheques.
10. When you’re ready to print, click the Print button at the bottom right of the panel.

Tips
•

Entries printed as cheques will always receive a new cheque number, beginning with the
number you enter in the Starting Cheque # eld, even if they already have a cheque
number. Don’t ll in a cheque number as you create your Entries, make sure you enter the
number of the rst paper cheque you’re printing in the Starting Cheque # eld, and you’re
all set.
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Print a group of Entries as cheques
1. Go to the Account menu at the top of your screen, down to the Go to Account submenu,
and click the name of the Account with the Entries you’d like to print as cheques. Cheques
can’t be printed from the All Accounts section.
2. Click the Entry button at the bottom of the document window.
3. Select the Entries you’d like to print as cheques. Click and drag vertically to select a group,
hold the Shift key on your keyboard while you click an Entry to extend your selection, and
hold the Command key while you click an Entry to add to or remove from your selection.
4. Go to the File menu and click the Print Cheques From Selection… menu item. A window
where you can see the Entries you’re about to print as cheques will appear.
5. By default, every Entry you selected will be printed. Remove the checkmark in the Print
column next to any Entries you’d rather print later.
6. Enter the cheque number from the rst paper cheque you’ll be printing in the Starting
Cheque # eld.
7. To set an address for a cheque, click the Address eld of its Entry. The next time you print
cheques, the same address will automatically be assigned to Entries with the same To.
8. When you’re ready to continue, click the Print… button at the bottom right of the window.
A standard print panel will appear.
9. Click the Template button, then click the name of the template that matches your preprinted cheque paper.
10. If the rst sheet of cheque paper you’ll be printing to isn’t a full sheet, place a checkmark
next to the First Page is option, then click the number button just to the right of that and
click the appropriate number of cheques.
11. When you’re ready to print, click the Print button at the bottom right of the panel.

Tips
•

Entries printed as cheques will always receive a new cheque number, beginning with the
number you enter in the Starting Cheque # eld, even if they already have a cheque
number. Don’t ll in a cheque number as you create your Entries, make sure you enter the
number of the rst paper cheque you’re printing in the Starting Cheque # eld, and you’re
all set.
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Print your Entries and Account Summaries
CheckBook Pro can easily print all the Entries in the selected Account, Folder, or Smart Folder, the
current search results, or an Account Summary.
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Print all Entries in an Account
1. Go to the Account menu at the top of your screen, then go to its Go to Account submenu.
Click the name of the Account with the Entries you’d like to print.
2. Click the Entry button at the bottom of the document window.
3. Go to the top right of the window and click the magnifying glass icon at the left side of the
search eld. A menu will appear.
4. Click the last item in the menu, Clear All Search Options.
5. Go to the File menu at the top left of your screen and click the Print... menu item. A print
window will appear.
6. Set up the print job options and click the Print button at the bottom right of the window.

Print the current search results
Learn how with these instructions.

Change the font used when printing Entries
1. Go to the CheckBook Pro menu at the top left of your screen and click the Preferences...
menu item. The Preferences window will appear.
2. Click the Entry Font button, then click the desired font. This will also change the font
CheckBook Pro uses to display your Entries.
3. Click the OK button and your preferences will be saved.
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Print the search results
1. Go to the File menu at the top left of your screen and click the Print... menu item. A print
window will appear.
2. Set up the print job options and click the Print button at the bottom right of the window.
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Print an Account Summary
1. Go to the Account menu at the top of your screen, then go to its Go to Account submenu.
Click the name of the Account with the Account Summary you’d like to print.
2. Click the Summary button at the bottom of the document window.
3. Click the name of the Account Summary you’d like to print in the list near the upper left of
the window.
4. Click the Print button at the top of the document window. A print window will appear.
5. Set up the print job options and click the Print button at the bottom right of the window.
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Preferences
Preferences affect the general behaviour of CheckBook Pro, how dates are displayed, and how
Entries are handled when you create or change them.
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General
The General preferences give you control of the following:
• Deposits Colour: the colour used to display and print Deposits and Scheduled Deposits
• Debits Colour: the colour used to display and print Debits and Scheduled Debits
• Use Colours For: whether your Deposits and Debits colours are used to colour balances
and totals
• Grid Colour: the colour used for the lines separating columns and rows
• Row Colours: the alternating colours behind Entries and Scheduled Entries
• Future Entries: how light or dark Entries with a date in the future will appear
• Entry Font: the font and size used to display and print Entries and Scheduled Entries
• Account Font: the font and size used to display Accounts in the Accounts drawer
• Save Search Options When Switching Accounts: whether search options for each Account
are saved when you switch Accounts or quit CheckBook Pro
• Quit When Accounts Document Is Closed: whether CheckBook Pro quits when you close
the current Accounts Document or displays the Launch window
• Check For Software Update On Launch: whether to check for a newer version of
CheckBook Pro each time you open the app. This option is not available when the app is
purchased from the Mac App Store.
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General preferences

Change your General preferences
1. Go to the CheckBook Pro menu at the top left of your screen and click the Preferences...
item. The Preferences sheet will appear.
2. Change your General preferences.
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3. Click the OK button to save your changes, or click the Cancel button to leave your
Preferences unchanged.
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Dates
The Dates preferences provide options for how CheckBook Pro displays and prints dates.
CheckBook Pro uses the date settings from the Language & Text Preferences Pane in OS X's
System Preferences. You decide in CheckBook Pro whether to use the short or long date format.

Dates preferences

Change your Date preferences
1. Go to the CheckBook Pro menu at the top left of your screen and click the Preferences...
item. The Preferences sheet will appear.
2. Click the Dates button at the top of the sheet.
3. Change your Dates preferences.
4. Click the OK button to save your changes, or click the Cancel button to leave your
Preferences unchanged.
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Entry
The Entry preferences give you the following options:
• When Adding Entries and When Changing Entries: which eld is automatically selected
when you add or change an Entry or Schedule.
• After Changing Entries: how search options are handled after you change an Entry. By
default, your search options are not cleared and are re-applied after changes are made, so
added or changed Entries might not be visible.
• Speak Entries: whether CheckBook Pro speaks Entries as you select them.
• Speak Amounts During Entry: whether CheckBook Pro speaks Entry amounts as you enter
them.
• Ask Before Removing Entries: whether CheckBook Pro asks you to con rm when you
remove an Entry.
• Number Cheques Automatically: whether you’d like CheckBook Pro to automatically insert
the next available cheque number when you click the Cheque # checkbox in a Debit Entry.
• Auto ll Categories: whether you’d like CheckBook Pro to auto ll the last Category
associated with a particular To/From item.
• Ask To Update To/From & Description Items: whether you’d like CheckBook Pro to ask
your permission to change all instances of a To/From item or Description so they have the
same case as what you’ve entered in the current eld. For example, if you entered
“sAFEPATH” by accident in a previous Entry’s To eld, you’d probably want to correct that
later by typing “Safepath”. The gotcha there is autocompletion will use the previous
“sAFEPATH”, automatically inserting it as soon as you nish your correction. Turn on the
Ask To Update To/From & Description Items option and CheckBook Pro will ask if it’s OK
to change all previous instances of “safepath”, with any combination of upper and lower
case letters, to the correction you just typed.
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Change your Entry preferences
1. Go to the CheckBook Pro menu at the top left of your screen and click the Preferences...
item. The Preferences sheet will appear.
2. Click the Entry button at the top of the sheet.
3. Change your Entry preferences.
4. Click the OK button to save your changes, or click the Cancel button to leave your
Preferences unchanged.
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Security
The Security preferences let you set an Accounts password so unauthorised visitors won’t be able
to open your Accounts document. CheckBook Pro will ask for the password before showing any
data.

Security preferences

If CheckBook Pro won’t accept your password
Try typing your password carefully, with the same capitalisation as when you rst set the password.
You could also try any other passwords you might have set as the Accounts password.
If neither of those ideas work, click the Forgot Password? button at the bottom left of the
password sheet to reset all the passwords in your Accounts document. You’ll be led through
sending a Challenge code to our support team. During regular business hours you should receive
a Response code within a couple of hours.

Are my passwords and data encrypted?
Your passwords are always encrypted in your Accounts document, but the data is not. OS X can
encrypt all of your data automatically with the FileVault feature. To control FileVault, go to the
Apple menu at the top left of your screen, click the System Preferences... menu item. The System
Security preferences
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Preferences window will appear. Type the word “FileVault” in the search eld at the top right of the
window.

Security preferences
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Maintenance
Backup your Accounts
Go to the File menu at the top left of your screen and click the Backup... menu item. Give the
backup a name you can recognise so it’ll be easy to nd if you need to restore it later. Store your
backups on another disk, such as a CD-R or USB thumb drive, so if anything catastrophic happens
to your Mac your data will be safe.

Maintenance
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Common questions and answers
How do I archive Entries, like when I start a new year?
1. Create a new Folder.
2. Click the Account in the Accounts drawer.
3. Select all the Entries for the previous year and before. You can drag-select or Shift-select.
4. Drag the selected Entries to the new Folder.

How do I move my Accounts to another Mac?
If your Accounts document is in iCloud or another cloud storage folder
1. Make sure iCloud or the other cloud storage service is set up on the other Mac.
2. Make sure CheckBook Pro is installed on the other Mac. If you purchased directly from our
online store you can download a fresh copy of CheckBook Pro from our website. If you
purchased from the Mac App Store, go to the Mac App Store, click the Apple ID at the
bottom left corner of the window (on macOS 10.14 and later) or click the Purchases
button at the top of the window (on macOS 10.13 and earlier), and install from there.
3. Open CheckBook Pro on the other Mac.
4. Go to the File menu at the top left of your screen and click the Open... menu item. Open
your document.

If your Accounts document is not in iCloud or another cloud storage folder
1. Make sure CheckBook Pro is installed on the other Mac. If you purchased directly from our
online store you can download a fresh copy of CheckBook Pro from our website. If you
purchased from the Mac App Store, go to the Mac App Store, click the Apple ID at the
bottom left corner of the window (on macOS 10.14 and later) or click the Purchases
button at the top of the window (on macOS 10.13 and earlier), and install from there.
2. Copy your Accounts document to the other Mac. You can get a copy by opening
CheckBook Pro on the original Mac, going to the File menu at the top left of your screen
and clicking the Backup... menu item.
3. Open CheckBook Pro on the other Mac.
4. Go to the File menu at the top left of your screen and click the Open... menu item. Open
your document.
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How do I print a Category detail report?
CheckBook Pro’s Account Summaries are perfect for Category detail reports. They have a setting
to show Entry details, and these details can be grouped and subtotalled by Category. Each
Account you create comes with a Category Details, Last Year and a Category Details, This Year
Account Summary, but you can make your own with any custom options you’d like: As you create
an Account Summary, set the Style to Entry Details and the Group By setting to Category. You
can then print the Account Summary when you need to.

How do I set up an Account to manage a credit card?
It’s pretty similar to the way you set up an Account to manage a current or savings Account. Just
set your Starting Balance to your credit card balance - but make sure it’s negative. As long as you
owe, your balance will remain negative. Enter charges as Debits and payments as Deposits.

How do I nd my serial number?
If you purchased from our online store, send a message to customerservice@splasm.com with the
name and email address you used to place your order.
If you purchased from the Mac App Store, you won’t need a serial number. If the app asks for one:
1. Quit the app.
2. Click the magnifying glass icon at the top right of your screen. A search eld will appear.
3. Search for “CheckBook Pro.app” without the quotes. Click the Show All In Finder item at
the top of the list. A window of search results will appear.
4. Move any result named CheckBook Pro or CheckBook Pro.app that also has the
CheckBook Pro icon to the Trash.
5. Empty the Trash.
6. Go to the Mac App Store.
7. Click the Purchases button at the top of the window.
8. Install the app.

Common questions and answers
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Get more help
• Connect with other users and share tips & tricks at our forums
• Get help at CheckBook Pro’s support page
• Watch CheckBook Pro’s video tutorials
• Contact CheckBook Pro’s support
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